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Cek Penguasaan Materi 

 

Dalam rangka mengetahui kemampuan awal peserta didik 

terhadap materi pembelajaran, berikut ini tersedia daftar 

pertanyaan yang harus dijawab: 

Jawablah pertanyaan di bawah ini sesuai dengan yang 

Anda ketahui. 

1. Sebutkan definisi penginderaan jauh! 

2. Sebutkan minimal tiga latar belakang hadirnya 

penginderaan jauh! 

3. Apa keunggulan penginderaan jauh dibandingkan teknologi 

tradisional sebelumnya? 

4. Sebutkan lima contoh pemanfaatan penginderaan jauh 

dalam bidang lingkungan hidup dan kehutanan! 
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BAB I 

KONSEP DASAR PENGINDERAAN JAUH 

 

A. Identitas Mata Kuliah 

Fak/Jur : Pertanian / Kehutanan  

Mata Kuliah  : Penginderaan Jauh Untuk 

Kehutanan 

Kode Mata Kuliah   : KHT 612101 

Jumlah SKS  : 3 (2-1) SKS 

Semester / pertemuan ke  : 5 / pertemuan ke 1 

Pokok Bahasan  : Konsep Dasar Penginderaan 

Jauh 

 

B. Capaian Dan Indikator 

I. Capain Pembelajaran:  

 1. Mahasiswa dapat menjelaskan definisi dan konsep 

Penginderaan Jauh (PJ). 

2. Mahasiswa dapat menjelaskan latar belakang dan 

perkembangan PJ. 

3. Mahasiswa dapat menjelaskan keungulan PJ. 

4. Mahasiswa dapat menyebutkan contoh pemanfaatan 

PJ. 
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II. Indikator Capain Pembelajaran: 

1.  Setelah mengikuti perkuliahan mahasiswa dapat:  

1. Menjelaskan definisi dan konsep Penginderaan 

Jauh (PJ) 

2. Menjelaskan latar belakang dan perkembangan 

PJ 

3. Menjelaskan keungulan PJ 

4. Menyebutkan contoh pemanfaatan PJ  

C. Definisi Dan Konsep Penginderaan Jauh  

C.1. Definisi Penginderaan Jauh 

Penginderan Jauh merupakan terjemahan kata dari bahasa 

inggris “Remote Sensing” yang merupakan istilah umum yang 

digunakan untuk menyebut suatu kegiatan pendugaan 

keterangan suatu objek dari jarak jauh tanpa perlu menyentuh 

atau mendatanginya (Lintz dan Simonett, 1976). Disiplin ilmu 

ini sering disebut merupakan cabang ilmu dari Geografi dan 

telah berkembang dengan cepat sehingga terdapat berbagai 

penafsiran dari beberapa ahli mengenai definisi atau 

pengertiannya. Pengertiannya pun berkembang seiring 

perkembangan teknologi yang digunakan. 

Penginderaan jauh telah didefinisakan secara bervariasi 

namun pada dasarnya merupakan ilmu pengetahuan atau seni 

untuk mengungkapkan sesuatu mengenai suatu objek tanpa 

menyentuhnya secara langsung (Fischer et al., 1976). 
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Sedangkan Colwell (1983) dalam Manual of Remote Sensing, 

American Society of Photogrammetry  pada tahun 1983 

membuat suatu definisi bahwa Penginderaan Jauh adalah 

Pengukuran atau pengumpulan informasi dari beberapa sifat 

objek atau fenomena dengan suatu alat perekaman yang tidak 

kontak secara fisik dengan obyek atau fenomena yang sedang 

diamati. Istilah penginderaan jauh di beberapa negara, antar 

lain Remote sensing (Amerika Serikat), Teledetection 

(Perancis), Telepercepcion (Spanyol) dan Fernerkundung 

(Jerman). 

Ahli lain juga mengutarakan pendapatnya mengenai defisni 

Penginderaan Jauh. Beberapa pengertian tersebut antara lain: 

a. Campbell (2002) 

Penginderaan jauh adalah ilmu untuk mendapatkan 

informasi tentang permukaan bumi seperti lahan dan air 

dari citra yang diperoleh dari jarak jauh. 

b. Lindgren (1985) 

Penginderaan jauh adalah teknik yang digunakan untuk 

memperoleh dan menganalisis bumi. 

c. Lillesand and Keifer (2003) 

Penginderaan jauh adalah ilmu atau teknik dan seni untuk 

mendapatkan informasi tentang objek, wilayah atau gejala 

dengan cara menganalisis data yang diperoleh dengan suatu 
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alat, tanpa hubungan langsung dengan objek wilayah atau 

gejala yang dikaji. 

C.2. Konsep Dasar Penginderaan Jauh 

Penginderaan jauh diawali penemuan teknologi kamera 

dimana gambaran suatu objek dapat ditangkap oleh alat 

sehingga mendorong manusia untuk memanfaatkannya lebih 

lanjut. Alat tersebut kemudian dikenal dengan kamera. 

Kamera bekerja berdasarkan prinsip-prinsip fisika optik 

dimana sensor yang digunakan tidak bersentuhan langsung 

dengan objek yang diamati tetapi hanya menyerap dan 

menangkap cahaya yang dipantulkan kembali oleh objek. 

Pengamatan mengenai suatu objek yang  mungkin berjarak 

jauh tanpa bersentuhan atau mendatangi objek secara langsung 

menimbulkan penggunaan remote sensing atau penginderaan 

jauh akhirnya digunakan sebagai istilah umum yang dikenal 

sampai sekarang. 

Penginderaan jauh menggunakan prinsip-prinsip dasar ilmu 

fisika terutama mengenai radiasi elektromagnetik karena 

proses yang terjadi dalam proses penginderaan jauh selalu 

melibatkan interaksi antara radiasi energi yang disengaja 

dengan target yang menjadi sasaran atau objek penelitian. 

Oleh karena itu, pengetahuan-pengetahuan dan pemahaman 

terhadap radiasi elektromagnetik sangat diperlukan oleh 
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seseorang yang ingin mendalami bidang ilmu penginderaan 

jauh. 

Ilustrasi yang dibuat oleh Canada Centre for Remote 

Sensing (CCRS) dalam sebuah buku Fundamentals of Remote 

Sensing  tahun 2014 menunjukkan proses yang terjadi dalam 

sebuh proses penginderaan jauh. Dimana terdapat alat-alat 

penunjang yang memungkinkan proses penginderaan jauh 

terjadi sampai diperoleh data citra yang digunakan sebagai 

bahan utama analisis.  

 

 

 

 

 

 

 

 

Gambar 1.1. Ilustrasi kegiatan Penginderaan Jauh 
Sumber: CCRS, 2014 

Keterangan Gambar: 
Bagian Keterangan 

A Sumber energi 

B Radiasi dan atmosfer 

C Interaksi dengan target  

D Perekaman energi oleh sensor 

E Transmisi, penerimaan dan pemrosesan data 

F Interpretasi dan Analisa 
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Campbell dan Wynne (2011) menggambarkan konsep 

penginderaan jauh dalam sebuah diagram yang ditunjukkan 

pada gambar dibawah ini. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Gambar 1.2. Konsep Penginderaan Jauh Campbell dan Wynne  

        (2011) 

G Aplikasi atau Pemanfaatan 

Objek 
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Data 
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C.2.1. Radiasi Elektromagnetik 

Cahaya sesungguhnya merupakan energi elektromagnetik 

yang merambat. James Clerk Maxwell (1831 – 1879) adalah 

seorang ilmuwan asal Inggris yang menyatakan bahwa cahaya 

adalah gelombang elektromagnetik dimana cepat rambat 

gelombang elektromagnetik sama dengan cepat rambat cahaya 

yaitu 3 × 10
8
 m/detik.  

 

Gambar 1.3. Ilustrasi kegiatan Penginderaan Jauh 
Sumber: CCRS, 2014 

 

Interaksi energi elektromagnetik insiden dengan materi 

tergantung pada struktur molekul dan atom objek. Energi 

dapat terarah, tersebar, ditransmisikan atau diserap secara 

terarah. Prosesnya disebabkan oleh interaksi foton dengan 
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elektron yang terletak di cangkang atom, yang menghasilkan 

eksitasi elektron dari cangkang (Konecny, 2003) 

 

C.2.2. Spektrum Elektromagnetik 

Spektrum elektromagnetik adalah rentang atau kisaran dari 

panjang gelombang terpendek (termasuk sinar gamma dan x-

rays) ke panjang gelombang terpanjang (termasuk gelombang 

mikro dan gelombang radio siaran). Diantaranya terdapat 

beberapa bagian spektrum elektromagnetik yang dapat 

berguna untuk penginderaan jarak jauh.  

Spektrum sinar ultraviolet atau UV yang memiliki panjang 

gelombang terpendek merupakan porsi yang sering digunakan 

dalam praktik penginderaan jauh dimana radiasinya hanya 

sedikit diluar sinar tampak (violet). Beberapa permukaan 

Bumi, terutama batuan dan mineral akan berpendar atau 

memancarkan cahaya tampak saat diterangi oleh radiasi UV 

(CCRS, 2014). 
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Gambar 1.4. Ilustrasi Spektrum Elektromagnetik 

Sumber: CCRS, 2014 

 

C.3. Macam Resoluasi Citra 

Resolusi pada disiplin ilmu penginderaan jauh sedikit 

berbeda karena isitlah resolusi dapat merujuk kepada empat 

istilah, yaitu: a) Resolusi Spasial; b) Resolusi spektral; c) 

Resolusi Temporal dan d) Resolusi Radiometrik. Berikut 

dijelaskan mengenai macam-macam resolusi yang dikenal 

dalam penginderaan jauh. 

a. Resolusi Spasial 

Resolusi spasial dalam penginderaan jauh berarti ukuran 

terkecil obyek yang dapat direkam oleh suatu sistem sensor 
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sehingga menunjukkan kerincian informasi yang dapat 

disajikan oleh suatu sistem sensor. Objek terkecil ini disajikan 

dalam sebuah piksel. Piksel dalam bahasa Inggris adalah pixel 

(picture element). Sabins (1997) mendefinisikan resolusi 

spasial sebagai kemampuan untuk membedakan diantara jarak 

dua objek yang berdekatan pada citra.  

Terdapat dua cara menyatakan resolusi spasial, yakni: 

resolusi citra dan resolusi medan. Resolusi Citra (citra 

resolution) dapat diartikan sebagai kualitas lensa yang 

dinyatakan dengan jumlah maksimum garis pada tiap 

milimeter yang masih dapat dipisahkan pada citra. Misal tiap 

garis tebalnya 0,01 mm. Ruang pemisah antara tiap garis juga 

sebesar 0,01 mm. Berarti tiap garis menempati ruang selebar 

0,02 mm atau pada tiap mm ada 50 garis. Dalam contoh ini 

berarti resolusi citranya sebesar 50 garis/mm. Secara teoritik 

maka resolusi citra yang terbaik 1.430 garis/mm. Resolusi 

Medan (ground resolution) ialah ukuran terkecil obyek di 

medan yang dapat direkam pada data digital maupun pada 

citra. Pada data digital resolusi medan dinyatakan dengan 

pixel. Semakin kecil ukuran terkecil yang dapat direkam oleh 

suatu sistem sensor, berarti sensor itu semakin baik karena 

dapat menyajikan data dan informasi yang semakin rinci. 

teknik pemrosesan sinyal secara inovatif dapat meningkatkan 

kualitas resolusi spasial (Richard J.A., 2000.) . 
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b. Resolusi Spektral 

Resolusi spektral menunjukkan kerincian panjang 

gelombang elektromagnetik yang digunakan dalam perekaman 

obyek pada sensor. Sensor satelit dewasa ini menunjukkan 

keunggulan berupa penggunaan beberapa saluran gelombang 

elekromagnetik atau disebut Band sehingga hasil 

perekamannya disebut citra multispektral. Keunggulan citra 

multispektral adalah peningkatan pengenalan objek seperti 

kebutuhan untuk mengenali dan membedakan badan air seperti 

air tawar, air laut maupun uap air di udara yang belum dapat 

dilakukan oleh sensor yang dirilis dibawah tahun 2010 an. 

Citra yang baik tentu saja disesuaikan dengan spesifikasi 

saluran/band yang tepat dengan persyaratan analisis yang 

dilakukan. Analisis air tentu saja membutuhkan saluran-

saluran rentang panjang gelombang elektromagnetik yang 

berbeda dengan analisis vegetasi maupun geologi. 

 

c. Resolusi Temporal 

Resolusi temporal adalah intensitas perekaman suatu 

wahana pada tempat/posisi yang sama. Satelit sebagai wahana 

sebuah sensor tentu memiliki waktu tertentu untuk mengorbit 

bumi sehingga terdapat jangka waktu untuk kembali mencapai 

posisi yang sama. Sebagai contoh, Satelit misi Landsat 

generasi pertama membutuhkan waktu mengorbit sekitar 18 
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hari sedangkan Landsat generasi kedua membutuhkan waktu 

16 hari untuk satu kali mengorbit bumi.  

Citra satelit yang memiliki resolusi temporal lebih singkat 

tentu saja menjadi pilihan yang lebih meyakinkan namun tetap 

disesuaikan dengan kebutuhan dan pendanaan yang ada. 

Perbaikan pada resolusi ini dapat memberikan peluang untuk 

terintegrasi studi dari beberapa disiplin ilmu yang berbeda 

untuk akan memberikan teknik-teknik baru pendeteksian 

(Njoku, E.G, 2000). 

 

d. Resolusi Radiometrik 

Resolusi radiometrik memiliki pengertian tingkat kepekaan 

sensor terhadap perbedaan terkecil kekuatan sinyal yang 

dihasilkan dari objek perekam sehingga dibedakan dari segi 

warna dan intensitas cahaya. Resolusi radiometrik 

menerangkan seberapa banyak informasi dari pantulan objek 

yang mampu direkam. Informasi dari pantulan tersebut 

disimpan pada saluran yang disebut band. semakin tinggi 

resolusi radiometrik sebuah citra maka semakin informasi 

yang bisa didapatkan.  

 

D. Perkembangan Penginderaan Jauh 

Dewasa ini perkembangan teknologi penginderaan jauh 

sudah berkembang sangat cepat, seorang dapat melakukan 
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kegiatan penginderaan jauh cukup menggunakan bantuan 

perangkat telepon genggam pintar atau smartphone secara 

langsung menggunakan bantuan aplikasi semisal google earth, 

google maps, Arcgis, Geo Tracker dan lain sebagainya. 

Namun dahulu kala saat wahana atau platform yang digunakan 

masih sangat terbatas, manusia sudah melakukan kegiatan 

penginderaan jauh untuk berbagai macam pemanfaatan.  

Penginderaan jauh tidak terlepas dari perkembangan ilmu 

fisika terutama dalam bidang fisika optik, penemuan kamera, 

perkembangan penduduk dan perang dunia. Keempat hal 

tersebut setidaknya secara langsung menyebabkan perlombaan 

negara-negara adikuasa untuk saling berlomba menjadi yang 

terdepan dalam mengembangkan dan memanfaatkan teknologi 

tersebut. 

Campbell dan Wynne (2011) dalam bukunya “Introduction 

to remote sensing” menyatakan tahapan urutan sejarah 

perkembangan dalam dunia penginderaan jauh yang disajikan 

pada tabel 1.1 dibawah ini. 

Tabel 1.1 Urutan Perkembangan Penginderaan Jauh 

Tahun Keterangan 

1800 Penemuan sinar inframerah oleh sir william herschel 

1839 Permulaan kegiatan fotografi 
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Tahun Keterangan 

1847 Demonstrasi spektrum inframerah yang ditunjukkan 

oleh A. H. L. Fizeau dan J. B. L. Foucault untuk 

menunjuk perpindahan muatan menggunakan cahaya 

tampak 

1850-1860 Fotografi menggunakan balon 

1873 Teori energi elekromagnetik yang dikembangkan oleh 

James Clerk Maxwell 

1909 Fotografi dari pesawat terbang 

1914-1918 Perang Dunia I: Pengintaian udara  

1920-1930 Pengembangan dan aplikasi awal fotografi udara dan 

fotogrametri 

1929-1939 Depresi ekonomi menghasilkan krisis lingkungan yang 

menyebabkan diadakannya kegiatan aplikasi foto udara 

oleh pemerintah 

1930-1940 Pengembangan radar di Jerman, Amerika Serikat, dan 

Inggris 

1939-1945 Perang Dunia II: aplikasi dari bagian tidak tampak dari 

spektrum elektromagnetik; pelatihan orang untuk 

akuisisi dan interpretasi foto udara 

1950-1960 Penelitian dan pengembangan kemiliteran 

1956 Penelitian Colwell pada deteksi penyakit tanaman 

dengan fotografi inframerah 

1960-1970 Penggunaan perdana istilah  remote sensing  

Satelit cuaca TIROS Observasi penginderaan jauh 

Skylab dari ruang angkasa 

1972 Peluncuran Satelit Landsat 1 

1970-1980 Kemajuan pesat dalam pengolahan citra digital 

1980-1990 Landsat 4: generasi baru sensor satelit Landsat 

1986 satelit observasi SPOT Earth milik negara Perancis  

1980an Perkembangan sensor hyperspectral (resolusi sangat 

tinggi) 
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E. Keunggulan Penginderaan Jauh 

Penginderaan jauh memiliki keunggulan apabila 

diperhitungkan dari luas bidang ilmu, frekuensi dan manfaat 

penggunaan. Hal ini disebabkan oleh beberapa faktor antara 

lain (Sutanto, 1994): 

 Citra menggambarkan objek, daerah, dan gejala di 

permukaan bumi dengan wujud dan letak objek yang mirip 

seperti di permukaan bumi, relatif lengkap, meliputi daerah 

yang luas, serta bersifat permanen. 

 Mampu menampilkan gambaran tiga dimensi. 

 Karaktersitik objek yang tidak tampak dapat diwujudkan 

dalam bentuk citra sehingga dimungkinkan pengenalan 

objeknya. 

 Citra dapat dibuat secara cepat meskipun untuk daerah 

yang sulit dijelajahi secara terestrial. 

 Merupakan satu-satunya cara untuk pemetaan daerah 

bencana. 

 Citra sering dibuat dengan periode ulang yang pendek. 
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Keunggulan lain dari penginderaan jauh adalah fleksibilitas 

penggunaan dan integrasi. Saat ini, perkembangan teknologi 

informasi yang pesat memungkinkan terjadinya integrasi 

penginderaan jauh dengan sistem informasi geografis (SIG) 

yang memungkinkan penginderaan jauh dimanfaatkan untuk 

berbagai keperluan oleh berbagai level tingkat kemampuan 

pengguna. Hal lain yang tidak terbantahkan dari keunggulan 

penginderaan jauh adalah cakupan wilayah yang mampu 

dijangkau sangat luas sehingga satuan biaya per satuan luas 

dapat menjadi terjangkau walaupun masih banyak pihak 

menyatakan bahwa penggunaan teknologi ini masih tergolong 

mahal. 

 

F. Pemanfaatan Penginderaan Jauh 

Teknologi penginderaan jauh dewasa ini digunakan secara 

luas oleh berbagai kalangan dari berbagai latar belakang 

disiplin ilmu. Pemanfaatannya tidak hanya terbatas pada 

bidang meterologi, geofisika, kehutanan dan pertanian tetapi 

berkembang juga pada bidang sosial, politik, kesehatan, 

militer, keamanan dan pertahanan, perencanaan, ekonomi, 

pemasaran, mitigasi bencana alam dan lain sebagainya.  
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Gambar 1.5. Pemanfaatan Teknologi Penginderaan Jauh   
      Untuk Identifikasi Jenis Pohon 
Sumber: Nevalainen, et al. (2017) 

Tautan: http://www.mdpi.com/2072-4292/9/3/185?utm_source = 

TrendMD &utm_medium=cpc&utm_campaign= 

Remote_Sens_TrendMD_0 
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Perkembangan kebutuhan dalam dunia kehutanan sendiri 

memang sebagian besar menggunakan teknologi penginderaan 

jauh untuk melakukan penetapan, perencanaan pekerjaan dan 

pengawasan kawasan hutan namun teknologi penginderaan 

jauh dapat dimanfaatkan untuk hal yang lebih luas seperti 

kegiatan manajemen Daerah Aliran Sungai (DAS), 

pengamatan perubahan penggunaan dan tutupan lahan, 

evaluasi kinerja, pengamatan habitat dan kebakaran hutan. 

Perkembangan internet juga mendorong perusahaan 

penyedia jasa konten informasi melahirkan produk-produk 

informatif berbasis penginderaan jauh dan sistem informasi 

geografis yang dapat diakses dengan mudah dan gratis oleh 

khalayak ramai seperti Google Earth yang merupakan produk 

dari Google.  

 

 

 

 

 

 

 

 

Gambar 1.6 Tampilan Google Earth Pro 
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G.  RANGKUMAN 

1. Penginderan Jauh istilah umum yang digunakan untuk 

menyebut suatu kegiatan pendugaan keterangan suatu 

objek dari jarak jauh tanpa perlu menyentuh atau 

mendatanginya (Lintz dan Simonett, 1976).  

2. konsep dasar penginderaan jauh adalah terdapat  

adanya cahaya yang merupakan radiasi elektromagnetik 

yang merambat dengan cepat rambat 3 × 10
8
 m/detik 

dimana setiap objek yang mengenainya akan menyerap dan 

atau memantulkan radiasi tersebut dengan intensitas yang 

berbeda-beda.  

3. Resoluasi pada disiplin ilmu penginderaan jauh dapat 

merujuk kepada empat istilah, yaitu:  

a. Resolusi spasial adalah Resolusi spasial dalam 

penginderaan jauh berarti ukuran terkecil obyek yang 

dapat direkam oleh suatu sistem sensor sehingga 

menunjukkan kerincian informasi yang dapat disajikan 

oleh suatu sistem sensor. Objek terkecil ini disajikan 

dalam sebuah piksel. 

b. Resolusi spektral adalah kerincian panjang gelombang 

elektromagnetik yang digunakan dalam perekaman 

obyek pada sensor. 

c. Resolusi temporal adalah intensitas perekaman suatu 

wahana pada tempat/posisi yang sama. 
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d. Resolusi radiometrik adalah tingkat kepekaan sensor 

terhadap perbedaan terkecil kekuatan sinyal yang 

dihasilkan dari objek perekam sehingga dibedakan dari 

segi warna dan intensitas cahaya. 

 

H.  PERTANYAAN DAN EVALUASI  

1. Jelaskan makna penginderaan jauh! 

2. Jelaskan konsep dasar penginderaan jauh! 

3. Jelaskan perbedaan resolusi spektral dan radiometrik! 

4. Apa saja konsekuensi peningkatan resolusi spasial 

sebuah citra? 

5. Resolusi citra seperti apa yang dibuthkan untuk 

pengamatan perubahan kerapatan hutan?  
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CEK PENGUASAAN MATERI 

 

Dalam rangka mengetahui kemampuan awal peserta didik 

terhadap materi pembelajaran, berikut ini tersedia daftar 

pertanyaan yang harus dijawab: 

Jawablah pertanyaan di bawah ini sesuai dengan yang Anda 

ketahui. 

1. Sebutkan dan terangkan tiga jenis wahana penginderaan 

jauh berdasarkan ketinggiannya! 

2. Terangkan jenis-jenis data yang dapat dihasilkan dari 

masing-masing wahana tersebut! 

3. Apakah peran sensor dalam penginderaan jauh? 
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BAB II 

SENSOR DAN WAHANA 

 

A. IDENTITAS MATA KULIAH 

Fak/Jur : Pertanian / Kehutanan  

Mata Kuliah : Penginderaan Jauh Untuk 

Kehutanan 

Kode Mata Kuliah  : KHT 612101 

Jumlah SKS : 3 (2-1) SKS 

Semester / pertemuan ke : 5 / pertemuan ke 2 

Pokok Bahasan : Sensor dan Wahana  

 

B. CAPAIAN DAN INDIKATOR 

I. Capain Pembelajaran:  

 Mahasiswa mampu mendapatkan data penginderaan jauh (PJ) 

berkualiatas secara mandiri. 

II. Indikator Capain Pembelajaran: 

 Setelah mengikuti perkuliahan mahasiswa dapat:  

1. Menjelaskan definisi, jenis dan contoh sensor 

2. Menjelaskan definisi, jenis dan contoh wahana  
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C. SENSOR 

Sensor merupakan salah satu instrumen penting dalam 

penginderaan jauh. Sensor memiliki peran dalam penyediaan 

data penginderaan jauh. Sensor memungkinkan pengguna 

mendapatkan keterangan dari objek yang diamati. 

C.1. Definisi Sensor 

Sensor dapat didefinisikan sebagai perangkat untuk 

mendeteksi dan menangkap radiasi elektromagnetik yang 

dipantulkan atau dipancarkan dari sebuah objek. Kamera 

digital, kamera saku, kamera pada ponsel adalah contoh-

contoh sederhana dari sensor jarak jauh yang kerap digunakan 

masyarakat.  

Karakteristik sebuah objek dapat diketahui dengan 

memperhitungkan radiasi elektromagnetik yang dipancarkan 

atau dipantulkan objek tersebut. Setiap jenis benda atau objek 

akan memiliki nilai radiasi elektromagnetik yang berbeda-

beda. Hal ini yang memungkinkan peneliti dapat mengetahui 

karakteristik suatu objek dari jarak yang jauh.  

 

C.2. Jenis-Jenis Sensor 

Sensor secara garis besar dapat dibagi menjadi dua 

berdasarkan sumber energi yang dipancarkan, yaitu sensor 

aktif dan sensor pasif (EOSDIS, 2018).  
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a. Sensor aktif  

Tipe sensor yang menyediakan sumber energi sendiri 

untuk menerangi objek yang diamati. Sensor aktif 

memancarkan radiasi ke arah target yang akan diamati lalu 

mendeteksi dan mengukur radiasi yang dipantulkan kembali 

oleh target. 

Mayoritas sensor aktif beroperasi di bagian gelombang 

mikro spektrum elektromagnetik, yang membuat mereka 

mampu menembus atmosfer di bawah sebagian besar kondisi. 

Teknik aktif melihat target dari salah satu ujung dasar dari 

panjang yang diketahui. Perubahan arah pandangan yang jelas 

(paralaks) terkait dengan jarak absolut antara instrumen dan 

target. Contoh jenis-jenis sensor aktif antara lain: Laser 

altimeter; Lidar; Radar; Ranging Instrument; Scatterometer 

dan Sounder.  

 

 

 

 

 

 

Gambar 2.1 Tampilan data LIDAR Jembatan Bixby, Monterey, 

Amerika Serikat 

Sumber: https://oceanservice.noaa.gov/facts/lidar.html 
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b. Sensor pasif 

Tipe sensor yang tidak menyediakan sumber energi sendiri 

dan mendeteksi radiasi yang dipancarkan atau dipantulkan 

oleh objek atau adegan yang diamati. Cahaya matahari yang 

terpantul merupakan sumber radiasi paling umum yang diukur 

oleh sensor pasif. Sebagian besar sistem pasif yang digunakan 

dalam aplikasi penginderaan jauh beroperasi di bagian yang 

terlihat, inframerah, inframerah termal, dan gelombang mikro 

spektrum elektromagnetik. 

Contoh jenis-jenis sensor pasif antara lain: Accelerometer; 

Radiometer hiperspektral; Pencitraan radiometer; Radiometer; 

Sounder; Spektrometer dan Spectroradiometer. 

 

Gambar 2.2. Satelit Landsat 8 dengan Sensor Pasif 
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Sumber: https://www.nasa.gov/content/goddard/nasa-usgs-
landsat-8-satellite-celebrates-first-year-of-success. 

D. WAHANA 

D.1. Definisi Wahana 

Wahana merupakan istilah dalam bahasa indonesia untuk 

mengartikan kata “Platform” dalam bahasa inggris.  Wahana 

dalam bidang ilmu penginderaan jauh merupakan istilah yang 

digunakan untuk menyebutkan perangkat atau alat atau 

kendaraan yang digunakan untuk membawa sensor 

penginderaan jauh.  

Apabila kamera sebuah ponsel pintar dikatakan sebagai 

contoh sensor penginderaan jauh yang lazim digunakan 

masyarakat umum. Maka perangkat ponsel pintar tersebut 

merupakan sebuah wahana karena merupakan perangkat 

ditempatkannya sensor.  

 

D.2. Jenis-Jenis Wahana 

Wahana diartikan sebagai kendaraan yang membawa alat 

pemantau. Utoyo (2009) berpendapat bahwa berdasarkan 

posisinya, wahana dapat diklasifikasikan menjadi tiga 

kelompok, yaitu: 

 Pesawat terbang rendah sampai medium (low to medium 

altitude aircraft) ketinggian antara 1.000–9.000 meter dari 
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permukaan bumi. Citra yang dihasilkannya adalah citra 

foto (foto udara). 

 Pesawat terbang tinggi (high altitude aircraft) dengan 

ketinggian sekitar 18.000 meter dari permukaan bumi. 

Citra yang dihasilkannya adalah citra udara 

dan multispectral scanner data. 

 Satelit dengan ketinggian antara 400–900 km dari 

permukaan bumi. Citra yang dihasilkan adalah citra satelit. 

 

D.3. Perkembangan Wahana PJ 

Perkembangan pesat teknologi penginderaan jauh memang 

sangat dipengaruhi akibat persaingan antar negara maju dalam 

persaingan kekuatan militer, pertahanan negara maupun 

perang sehingga memacu negara-negara maju untuk saling 

bersaing menciptakan dan meningkatkan kemampuan 

teknologi dalam negeri untuk mengamati, memperkirakan dan 

mengawasi kemampuan negara pesaing lainnya. 

Perang dingin yang terjadi antara Amerika Serikat dan Uni 

Sovyet setelah perang dunia kedua mendorong terjadinya 

perlombaan persaingan teknologi alat perang dan intelijen, 

salah satunya teknologi satelit yang berkembang pesat pada 

tahun 1960-an.  
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Indonesia termasuk negara berkembang yang saat itu 

masih tertinggal dalam pengembangan teknologi 

penginderaan jauh. Namun saat ini upaya keras telah 

dilakukan negara untuk ikut serta mengembangkan teknologi 

penginderaan jauh untuk kepentingan komunikasi, 

pengamatan lingkungan dan pendidikan  

 

 

 

 

 

 

 

 

 

Gambar. 2.3 Awal Perkembangan Penginderaan Jauh 
Sumber: Baumann, 2014 
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Gambar 2.4 Beberapa Wahana Penginderaan Jauh Vegetasi 
Sumber: Salami et al., 2014. 

 

Kelemahan penggunaan teknologi penginderaan jauh di 

Indonesia adalah minimnya infrastruktur terkait pengadaan 

citra dengan kualitas sangat tinggi (Hyperspectral) dan 

update. Kebanyakan data citra masih didapatkan dari sumber-

sumber luar negeri baik yang berbayar, gratis atau tidak 

berbayar melalui mekanisme kerjasama antar negara. 

Perkembangan tren robotika dan fotografi yang dapat 

diakses oleh perorangan maupun organisasi kecil juga ikut 

mendorong perkembangan teknologi penginderaan jauh lebih 

efisien.  
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Gambar 2.5. Konfigurasi UAV Tarot 960 hexacopter milik 
Finnish Geospatial Research Institute (FGI) 
Finlandia untuk analisis vegetasi. 

Sumber: Nevalainen et al., 2017 

 

Robot terbang atau lebih dikenal dengan drone dan UAV 

(unmanned aerial vehicle) yang dipandu oleh modul GPS dan 

penambahan kamera sebagai sensor optik mampu menjadi 

alternatif penyediaan wahana dan sensor berbiaya murah.dan 

tepat untuk penggunaan pada wilayah dengan luasan kecil dan 

menengah.  

 

E.  Rangkuman 

1. Sensor adalah perangkat untuk mendeteksi dan menangkap 

radiasi elektromagnetik yang dipantulkan atau dipancarkan 

dari sebuah objek. 

2. Sensor dapat dibagi menjadi:  

a. Sensor aktif, yang menyediakan sumber energi sendiri 

untuk menerangi objek yang akan diamati;  

b. Sensor pasif, yang tidak menyediakan sumber energi 

sendiri dan mendeteksi radiasi yang dipancarkan atau 

dipantulkan oleh objek atau adegan yang diamati. 

3. Wahana adalah perangkat atau alat atau kendaraan yang 

digunakan untuk membawa sensor penginderaan jauh.  
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4. Wahana berdasarkan ketinggiannya dapat diklasifikasikan 

menjadi tiga kelompok, yaitu:  

a. Pesawat terbang rendah sampai medium (low to medium 

altitude aircraft);  

b. Pesawat terbang tinggi (high altitude aircraft) dan  

c. Satelit dengan ketinggian antara 400–900 km dari 

permukaan bumi.  

 

F.  Pertanyaan Dan Evaluasi  

1. Sebutkan faktor yang mempengaruhi perkembangan 

teknologi bidang penginderaan jauh berkembang pesat! 

2. Wahana yang cocok digunakan untuk memantau kondisi 

kesehatan tanaman suatu perkebunan adalah? Sebutkan 

alasannya! 

3. Apakah sensor pasif baik digunakan pada pengambilan 

data dimalam hari? Sebutkan alasannya! 

4. Teknologi pertahanan dan keamanan milik TNI untuk 

mendeteksi pesawat asing termasuk dalam sensor? 

5. Wahana yang lebih tepat digunakan untuk memantau 

kebakaran hutan adalah? Sebutkan alasannya! 
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CEK PENGUASAAN MATERI 

 

Dalam rangka mengetahui kemampuan awal peserta didik 

terhadap materi pembelajaran, berikut ini tersedia daftar 

pertanyaan yang harus dijawab: 

Jawablah pertanyaan di bawah ini sesuai dengan yang Anda 

ketahui. 

1. Sebutkan macam-macam data yang digunakan dalam 

penginderaan jauh! 

2. Sebutkan karakteristik data vektor dan Raster! 

3. Apa yang dimaksud dengan citra? 

4. Apa yang dimaksud dengan scene? 
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BAB III 

DATA PENGINDERAAN JAUH 

 

A. Identitas Mata Kuliah 

Fak/Jur : Pertanian / Kehutanan  

 Mata Kuliah : Penginderaan Jauh Untuk 

Kehutanan 

 Kode Mata Kuliah  : KHT 612101 

 Jumlah SKS : 3 (2-1) SKS 

 Semester / pertemuan 

ke 

: 5 / pertemuan ke 3-4 

Pokok Bahasan : Data Penginderaan Jauh 

 

B. Capaian Dan Indikator 

I. Capain Pembelajaran:  

 Mahasiswa mampu menjelaskan jenis data yang 

digunakan dalam PJ dan tahapan pengumpulan data 

tersebut. 

II. Indikator Capain Pembelajaran: 

 Setelah mengikuti perkuliahan mahasiswa dapat:  

1. Menjelaskan jenis data yang digunakan dalam PJ 

2. Menjelaskan tahapan pengumpulan data yang dibu-

tuhkan. 
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C. Jenis-Jenis Data Pj 

Pada bab sebelumnya, sudah membahas berbagai macam 

platform/wahana yang digunakan dalam kegiatan 

penginderaan jauh dan perkembangan beberapa sensor yang 

ditempatkan pada wahana tersebut. Pada kegiatan 

penginderaan jauh, analisis yang dilakukan pasti 

membutuhkan data-data hasil tangkapan sensor pada wilayah 

tertentu yang diamati sebagai bahan utama pekerjaan. 

Teknologi terus dikembangkan untuk mendapatkan data 

dengan resolusi terbaik sehingga sumber data yang menjadi 

bahan analisis membuahkan hasil yang semakin mendekati 

kenyataan sebenarnya dilapangan. 

Perkembangan teknologi informasi dan komputer pada era 

digital ini menjadikan beberapa kemudahan bagi manusia 

dalam melakukan pekerjaannya. Data penginderaan jauh juga 

mengalami perkembangan terutama dalam hal teknologi 

penyimpanan data kedalam bentuk digital berupa file 

komputer dalam berbagai format ekstensi dan hal tersebut 

sudah menjadi hal yang biasa bagi seluruh lapisan masyarakat.  

Bentuk data dalam bentuk file digital memudahkan praktisi 

maupun orang awam dari berbagai tempat bahkan negara yang 

berbeda untuk bisa menampilkan data, mengirim dan berbagi, 
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melakukan perbandingan sampai melakukan pendugaan dan 

analisis berdasarkan file yang tersedia.  

Terdapat beberapa macam data yang digunakan dalam 

penginderaan jauh, hal tersebut tergantung dari wahana dan 

sensor yang digunakan dalam pengumpulan data (Lillesland et 

al, 2007). Namun yang paling penting adalah jenis dan tahapan 

analisis yang dilakukan karena akan sangat menentukan jenis 

data penginderaan jauh yang dibutuhkan. Namun secara garis 

besar, data hasil tangkapan sensor dan sudah diolah dalam 

bentuk file digital sebagai bahan analisis penginderaan jauh 

dapat dibagi menjadi dua kelompok , yaitu:  

1. Data Vektor, data yang menampilkan pola keruangan 

dalam bentuk titik, garis, kurva atau poligon. Basis dari 

data vektor titik yang disebut titik kontrol atau nodes yang 

memiliki posisi sumbu x, sumbu y dan arah (sumbu z) 

(Prahasta, 2009). Setiap alur pada vektor bisa ditambahkan 

atribut, termasuk ketebalan garis, bentuk, kurva, warna 

garis, dan warna isi. 

Contoh: data jalan, sungai, posisi dalam ekstensi shapefile 

maupun gpx. 
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2. Data Raster, struktur data dot matrix, yang mewakili kotak 

grid pixel pada umumnya, atau warna poin, yang dapat di 

lihat via monitor, kertas, atau media lainnya. Sehingga 

biasanya kualitas gambar dari data jenis raster dinilai 

berdasarkan jumlah pixel-nya. 

   Contoh: Citra satelit, Citra radar, DEM. 

 

Penjelasan lebih lanjut mengenai data vektor dan raster 

dapat dilihat pada gambar dibawah ini yang menampilkan 

ilustrasi jenis data vektor dan raster pada aplikasi sederhana 

penginderaan jauh. Perbedaan lebih jelas antara data vektor 

dengan data raster sangat terlihat apabila dilakukan perbesaran 

pada gambar jenis vektor dan raster. Pada gambar jenis data 

raster telihat semakin buram apabila dilakukan perbesaran 

maksimal menggunakan perangkat lunak pada komputer 

sedangkan pada gambar jenis data vektor hal tersebut tidak 

akan ditemui. Perhatikan pada ganbar dibawah ini !  
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Gambar 3.1. Perbesaran pada citra raster dan vektor latar wilayah Kotamadya Bandar Lampung 
Sumber Citra: BingMaps, akuisisi januari 2017. 

Kota Bandar Lampung 

Vektor 

Raster 
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Jenis data vektor dan raster memiliki kelebihan dan 

kekurangan masing-masing. Oleh karena itu, kelebihan dan 

kekurangan jenis data dalam kegiatan penginderaan jauh perlu 

diketahui untuk kebutuhan tindakan analisis dan rangkaian 

pekerjaan yang akan dilakukan. 

Analisis citra digital biasanya dilakukan dengan 

menggunakan struktur data raster di mana setiap citra 

diperlakukan sebagai susunan nilai. Struktur data raster 

menawarkan keuntungan untuk manipulasi nilai-nilai pixel 

pada pengolahan, karena mudah untuk menemukan posisi dan 

dan nilai-nilai pixel tersebut.  

Format vektor menggunakan penutupan poligonal dan 

batas-batas sebagai unit fundamental untuk analisis dan 

manipulasi. Format vektor tidak sesuai untuk analisis digital 

data penginderaan jauh, meskipun kadang-kadang kita 

mungkin ingin menampilkan hasil analisis menggunakan 

tambahan file berformat vektor. Seringkali perangkat keras 

untuk melakukan analisis penginderaan jauh harus disesuaikan 

untuk memenuhi kualifikasi minimal perangkat lunak 

pengolah data format raster yang membutuhkan sumberdaya 

cukup besar (Campbell dan  Wynne, 2011). 
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Tabel 3.1. Perbandingan data vektor dengan data raster 

Data Vektor Data Raster 

Kelebihan 

1. Lebih efisien dalam 

ruang penyimpanan. 

2. Memiliki resolusi 

spasial yang tinggi. 

3. Representasi grafis data 

spasialnya sangat mirip 

dengan peta garis buatan 

manusia. 

4. Transformasi koordinat 

dan proyeksi tidak sulit 

dilakukan. 

Kelebihan 

1. Struktur data yang 

sederhana. 

2. Mudah dimanipulasi 

dengan fungsi 

matematis sederhana. 

3. Teknologi yang 

digunakan cukup 

murah. 

4. Overlay data raster 

dengan data inderaja 

mudah dilakukan. 

Kekurangan 

1. Struktur data kompleks. 

2. Data tidak mudah 

dimanipulasi. 

3. Memerlukan perangkat 

komputer yang lebih 

mahal. 

4. Overlay beberapa layer 

vektor secara simultan 

memerlukan waktu 

lama. 

Kekurangan 

1. Memerlukan ruang 

penyimpanan yang 

besar. 

2. Transformasi 

koordinat dan proyeksi 

sulit dilakukan. 

3. Lebih sulit untuk 

merepresentasikan 

hubungan topologikal. 

 

Saat ini banyak sekali instansi negara maupun swasta 

dari berbagai negara yang menyediakan sumber data 
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penginderaan jauh dengan beragam kualitas dan waktu 

perekaman yang selalu diperbaharui (update).  

Data-data penginderaan jauh dapat berupa: 

1. Foto Udara (bentuk digital atau hasil scan) 

2. Peta Digital (Peta hasil scan) 

3. Citra Satelit 

4. Citra Radar 

 

Beberapa contoh data penginderaan jauh dapat dilihat pada 

gambar dibawah ini. 
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Gambar 3.2. Contoh Macam Data Penginderaan Jauh 

 

 

 

 

 

 

 

 

 

 

 

 

 

1
. 

2
. 

1. Keterangan: 

1. Foto udara wilayah sekitar Sungai Missisipi, Amerika Serikat Tahun 

1980. 
Sumber: https://earthexplorer.usgs.gov/browse/aircraft/phoenix/aerial/4   

2      Peta digital blok penanaman  Register 47, Lampung Tengah. 

Sumber: Dokumen Pribadi, 2016. 

 



 

III-11 | D a t a  P e n g i n d e r a a n  J a u h  

 

 

Lanjutan Gambar 3.2. Contoh Macam Data Penginderaan Jauh. 

 

 

 

 

 

 

 

 

 

 

 

 

4
. 

3 

2. Keterangan: 

2. Foto udara Citra satelit Landsat 8 Tahun 2017 Wilayah sekitar Prov. Lampung, Diolah. 

4.     Citra DEM SRTM sekitar wilayah Kab. Lampung Timur Tahun 2011. 
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D.  Tahap Pengumpulan Data 

Bahan analisis penginderaan jauh mensyaratkan kualifikasi 

citra yang baik sehingga hasil analisis yang dilakukan dapat 

dipertanggungjawabkan karena citra sebagai sumber data 

merupakan perekaman melalui sensor sebagai alat perekam 

yang tentu saja memiliki keterbatasan dan terkadang kendala 

teknis. Kondisi lingkungan dan cuaca juga berkontribusi 

terhadap keterbatasan alat. Oleh karena itu sangat penting 

untuk melakukan penyeleksian data. Hal-hal yang perlu 

diperhatikan dalam melakukan seleksi data penginderaan jauh 

sebelum melakukan analisis dijelaskan pada bagian dibawah 

ini. 

D.1. Menetapkan Scene 

Penetapan scene berhubungan dengan wilayah yang akan 

diteliti atau dianalisis sehingga pemilihan scene tertentu 

merupakan cara untuk efektifitas. Sensor pada perangkat 

satelit dan pesawat juga memiliki prinsip kerja yang sama 

seperti kamera digital yang mempunyai batas cakupan 

perekaman sehingga pada menu opsi atau pilihan di situ 

penyedia data biasanya disertakan menu untuk memilih 

wilayah yang akan diteliti atau sering disebut dengan istilah 

AOI (Area Of Interest).  

Pada wilayah penelitian yang luas maka diperlukan lebih 

dari satu scene untuk melakukan analisis. Penyedia citra 
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seperti USGS (United State Geological Survey) dan sentinel 

menambahkan opsi pemilihan sesuai wilayah yang diinginkan. 

Pada situs milik https://earthexplorer.usgs.gov, pengguna 

dapat mengunduh data berdasarkan pembagian scene yang 

dibagi berdasarkan nomor path dan row sesuai dengan hasil 

tangkapan sensor.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Gambar 3.3. Path dan Row Wilayah Indonesia untuk 
Mengunduh Citra Satelit Landsat Milik USGS 



 

III-14 | P a g e  

 

Sumber: http://geospasial.net/2014/12/download-citra-landsat 

-8-usgs. 

Sistem Path dan Row mengasumsikan bumi kedalam 

proyeksi datar dan kemudian dilaku-kan pembagian kedalam 

kotak sesuai luasan satu kali tangkapan sensor yang terpasang 

pada satelit. Setiap kotak mewakili luasan Path adalah urutan 

kotak berdasarkan baris dari sebelah timur ke barat sedangkan 

Row adalah urutan baris dari arah utara ke selatan. 
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Gambar 3.4. Tampilan Situs https://earthexplorer.usgs.gov Saat Pengunduhan Citra Landsat  

                   Sekitar Wilayah Provinsi Lampung

 

Path: 
123 

Row: 63 
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D.2. Tutupan Awan 

Permasalahan yang sering ditemukan pada citra 

terutama pada wilayah tropis seperti Indonesia adalah 

seringnya muncul awan baik pada malam maupun siang hari 

dengan persebaran yang cukup banyak pada setiap scene. Hal 

ini disebabkan kondisi alamiah seperti evaporasi dari badan air 

maupun tumbuhan. Kondisi maupun bentuk penggunaan lahan 

yang tertutup dibawahnya tidak dapat terlihat. 

Meskipun terdapat beberapa cara dan teknik yang 

dikembangan untuk mengatasi gangguan penampakan awan 

tersebut. Namun tetap saja akan berdampak pada pengurangan 

kualitas citra dan mempengaruhi akurasi hasil analisis akhir. 

Kondisi penampakan awan mengharuskan pengguna 

untuk melakukan seleksi yang ketat terhadap citra yang akan 

diunduh. Pemilihan citra mutlak diperlukan untuk 

memaksimalkan hasil analisis terutama pada analisis 

klasifikasi tutupan lahan dan penggunaan lahan.  

Secara normatif dikalangan peneliti, dipersyaratkan 

bahwa tutupan awan maksimal setiap scene yang 

diperbolehkan sebagai bahan analisis adalah 10 %. Dengan 

demikian diharapkan hasil analisis tidak terganggu secara 

signifikan. Saat mencari data juga dapat dipilih citra yang 

tidak ada tutupan awan sama sekali pada area yang akan 

dianalisis apabila area tersebut memiliki luas wilayah yang 
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lebih kecil walaupun kondisi tutupan awan pada scene tersebut 

cukup tinggi diatas 10%. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Gambar 3.5. Perbandingan Scene Citra Satelit Landsat 8 OLI   
   Dengan Tutupan Awan Maksimal 10 persen 
Keterangan:  

Gambar 1 merupakan liputan wilayah jakarta tanggal 13 mei 2016, 

Path:122 dan Row:64.  

Gambar 2 merupakan liputan wilayah Inggris tanggal 05 Juni 2016, 

Path:203 dan Row:23

1 

2 
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E.  Rangkuman 

1. Jenis data dalam penginderaan jauh adalah Vektor dan 

Raster. 

2. Jenis data vektor efisien dalam penyimpanan dan 

resolusi spasial tinggi namun kurang informatif. 

3. Jenis data raster memiliki struktur data sederhana dan 

mudah dimanipulasi dan lebih informatif namun 

memerlukan kapasitas ruang penyimpanan yang besar 

dalam komputer. 

4. Bentuk data penginderaan jauh, yaitu: Foto Udara 

(bentuk digital atau hasil scan); Peta Digital (Peta hasil 

scan); Citra Satelit dan Citra Radar. 

5. Seleksi data penginderaan jauh diperlukan untuk 

mendapatkan hasil analisis yang baik dengan melakukan 

pemilihan Scene sesuai lokasi penelitian, minimal 

tutupan awan (< 10%), resolusi spasial tinggi, resolusi 

spektral, temporal dan radiometrik sesuai dengan 

kebutuhan. 

 

F.  Pertanyaan Dan Evaluasi  

1. Citra dengan kriteria seperti apa yang harus disiapkan 

sebelum memulai analisis? 

2. Tuliskan perbedaan data jenis vektor dengan jenis 

raster! 
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3. Kualitas citra hasil liputan di Indonesia sering menemui 

masalah, sebutkan masalah tersebut dan bagaimana cara 

untuk mengatasinya? 

4. Mengapa ketika pengunduhan citra satelit ditemui 

Scene? 
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CEK PENGUASAAN MATERI 

 

Dalam rangka mengetahui kemampuan awal peserta didik 

terhadap materi pembelajaran, berikut ini tersedia daftar 

pertanyaan yang harus dijawab: 

Jawablah pertanyaan di bawah ini sesuai dengan yang Anda 

ketahui. 

1. Apa yang dimaksud dengan koreksi geometri? 

2. Mengapa perlu dilakukan koreksi geometri pada citra? 

3. Apa yang dimaksud dengan koreksi radiometrik? 

4. Mengapa perlu dilakukan tindakan koreksi radiometrik? 

5. Apa yang dimaksud pan sharpening? 

6. Pada kondisi bagaimana dipelukan tindakan pan 

sharpening? 

7. Apa urgensi melakukan  mosaic scene? 

8. Apakah diperlukan tindakan mosaic scene pada citra 

Landsat 8 untuk wilayah provinsi Jakarta? 

9. Mengapa diperlukan clipping pada citra? 

10. Apa yang dimaksud dengan AOI (Area of Interest)? 

11. Sebutkan pengertian Kombinasi Band! 

12. Sebutkan tiga macam citra yang membutuhkan tindakan 

Kombinasi Band! 
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BAB IV 

PENYIAPAN CITRA PENGINDERAAN JAUH 

 

A. Identitas Mata Kuliah 

Fak/Jur : Pertanian / Kehutanan  

 Mata Kuliah : Penginderaan Jauh untuk 

Kehutanan 

 Kode Mata Kuliah  : KHT 612101 

 Jumlah SKS : 3 (2-1) SKS 

 Semester / pertemuan 

ke 

: 5 / pertemuan ke 5-10 

Pokok Bahasan : Persiapan Citra Penginderaan 

Jauh 

 

B. Capaian Dan Indikator 

I. Capain Pembelajaran:  

 Mahasiswa dapat melakukan preprocessing atau 

penyiapan  citra sesuai AOI (Area Of Interest), berupa 

tindakan:  

1. Koreksi geometrik 

2. Koreksi Radiometrik  

3. Mosaic scene 

4. Clipping  

5. Kombinasi Band 

6. Pan sharpening 
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II. Indikator Capain Pembelajaran: 

 Setelah mengikuti perkuliahan mahasiswa dapat:  

1. Menjelaskan konsep dan urgensi koreksi  geometri 

2. Melakukan koreksi geometri citra 

3. Menjelaskan konsep dan urgensi  koreksi radiometrik  

4. Melakukan koreksi radiometrik 

5. Menjelaskan konsep dan urgensi pan sharpening 

6. Melakukan pan sharpening  

7. Menjelaskan konsep dan urgensi  mosaic scene 

8. Melakukan  mosaic scene  

9. Menjelaskan konsep dan urgensi  clipping  

10. Melakukan  clipping 

11. Menjelaskan konsep dan urgensi Kombinasi Band  

12. Melakukan Kombinasi Band  

 

C. Penyiapan Citra 

C.1. Koreksi Geometrik 

Koreksi geometrik merupakan koreksi untuk distorsi 

geometrik yang disebabkan varisi-variasi pada sensor geometri 

di bumi dan akibat konversi data menjadi koordinat bumi 

sebenarnya (bujur dan lintang) pada permukaan bumi yang 

diamati (CCRS, 2014) 

Citra pengindraan jauh yang akan digunakan sebagai bahan 

dalam melakukan analisis atau penelitian memiliki kondisi 

spesifik tertentu yang membutuhkan perlakuan untuk 
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memperbaiki kondisi nya sehingga menjadi sesuai standar 

yang dibutuhkan. 

Kondisi spesifik yang dimaksud antara lain adalah 

keterbatasan dalam ketepatan lokasi citra dengan lokasi 

sebenarnya secara geografis. Saat ini, tindakan koreksi 

geometrik tidak diperlukan untuk citra-citra akuisisi terbaru 

semisal Landsat 8 karena kemajuan teknologi yang 

memungkinkan tingkat presisi yang tinggi.  

Tindakan koreksi diperlukan pada citra akuisisi lama 

seperti Landsat 5 dan sebelumnya maupun citra bentuk digital 

namun formatnya tidak memiliki referensi geografis seperti 

citra unduhan Google Earth maupun dari sumber cetak yang 

telah di scan ulang dan sehingga terjadi perbedaan pembacaan 

alat dan hasil luaran yang dimungkinkan akibat penurunan 

presisi alat sehingga diperlukan tindakan koreksi geometrik. 

Oleh karena itu, pengecekan lapangan dalam penginderaan 

jauh terutama untuk kebutuhan penelitian tetap disarankan 

untuk dilakukan. 

Koreksi geometrik dapat dilakukan dengan melakukan 

tindakan yang dikenal dengan “Georeferensi” dengan 

memasukkan koordinat lokasi yang tepat pada citra awal yang 

memiliki koordinat belum tepat. Lokasi yang dijadikan 

referensi koordinatnya dikenal dengan istilan GCP (Ground 

Control Point) atau dalam istilah bahasa indonesia dikenal 

sebagai titik kontrol atau titik ikat. 
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Kemajuan teknologi memungkinkan pengguna dapat 

mengakses data-data spasial dengan mudah dan murah. 

Google Earth yang merupakan salah satu aplikasi milik 

Google dapat dimanfaatkan untuk mendapatkan citra resolusi 

tinggi sebagai salah satu bahan pedukung kegiatan analisis 

penginderaan jauh.  

Pada buku ini dicontohkan rangkaian langkah melakukan 

kegiatan koreksi geometrik. 

a.  Mengunduh dan memasang perangkat lunak “Google Earth 

Pro” yang dapat diunduh secara bebas dari tautan: 

https://earth.google.com/download-earth.html. 

 

 

 

 

 

b. Mengunduh citra dengan AOI yang diinginkan (Contoh: 

Kawasan Kampus Universitas Lampung)  
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c. Membuka perangkat lunak Qgis 2.18 dan melakukan 

tindakan koreksi geometrik dengan membuka menu: “Raster” 

> “Georeferencer”  > “Georeferencer…” 

 

 

 

 

 

 

 

 

 

 

d. Membuka menu: “File” > “Open Raster” dan mengunduh 

file hasil pengunduhan dari Google Earth. 
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Tampilan file unggahan dan siap untuk dikoreksi 

 

 

 

 

 

 

 

 

 

e. Menambahkan koordinat (minimal 4 titik untuk hasil 

koreksi yang lebih baik) pada titik tertentu yang sudah 

dicatat sebelumnya. Klik pada icon “Add Point” dan klik 

kiri pada titik yang ingin ditambahkan koordinatnya. 

 

 

 

 

 

 

 

 

 

Add Point 
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1 

 

f. Mengetikkan koordinat dengan posisi x (East/Bujur) dan y 

(North/Lintang) untuk masing-masing titik. 

 

 

 

 

 

 

 

 

 

 

Catatan:  X/East = Bujur Timur (nilai positif) 
              = Bujur Barat (nilai negatif) 

Y/North = Lintang Utara (nilai positif) 

  = Lintang Selatan (nilai negatif) 

Input koordinat titik telah selesai dilakukan untuk empat titik 

yang tersebar pada kawasan kampus unila. 
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g. Menyimpan rekaman koordinat baru dan menampilkan pada 

jendela kerja. 

     Klik pada icon “Transformation Settings” untuk    

menentukan kriteria transformasi keterangan geografis 

yang diinginkan pengguna. 

 

 

 

 

Tentukan nama dan lokasi file output sesuai keinginan 

pengguna dan klik tombol “Ok”. 
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Klik pada icon “Start Georeferencing” untuk menjalankan 

perintah koreksi geometrik. 

 

 

Proses berjalan dengan tampilan jendela pesan. 

 

 

 

 

 

 

Pengguna menunggu proses berlangsung beberapa saat 

tergantung dari spesifikasi perangkat keras (komputer PC 

atau Laptop) yang digunakan. 
 

h. Hasil koreksi geometrik, citra sudah memiliki referensi 

geografis 
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C.2. Koreksi Radiometrik 

Koreksi radiometrik merupakan tindakan yang dilakukan 

untuk mengkoreksi nilai piksel pada citra (Chander et al, 

2009). Hal ini disebabkan karena dimungkinkan terjadinya 

penyimpangan pembacaan akibat gangguan sensor atau 

atmosfer dan ketidaksesuaian saat dilakukan konversi data 

sehingga dengan melakukan koreksi radiometrik akan 

dihasilkan data yang akurat dalam arti mewakili tingkat emisi 

dan pantulan radiasi sebenarnya. Koreksi yang dilakukan 

tergantung dari jenis sensor dan wahana yang digunakan.  

Koreksi radiometrik perlu dilakukan pada data citra yang 

mengalami gangguan sebagai berikut (Rogass et al., 2011):  

 Striping: disebabkan respons sensor yang berubah karena 

perubahan suhu atau umur/masa pakai. 

 (partially) missing lines: disebabkan kelemahan pada 

peralatan pemindaian, transmisi data untuk perekaman. 

 illumination and view angle effects: disebabkan perubahan 

posisi matahari terhadap bumi 

 sensor calibration: disebabkan gangguan internal sensor 

karena pemakaian atau kegagalan teknis fungsi 

 terrain effects: disebebkan perbedaan ketinggian dimana 

pada lereng dengan ketinggian dan sudut tertentu 

mendapatkan intensitas penyinaran matahari lebih tinggi 

dibandingkan lereng dengan ketinggian dan sudut berbeda. 
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 atmospheric correction: disebabkan gangguan pada 

atmosfer seperti debu antariksa, awan, gejala iklim dan lain 

sebagainya. 

 

C.3. Mosaic scene 

Kegiatan analisis spasial seringkali dilakukan untuk 

wilayah administrasi atau regional yang sudah ditentukan 

dengan batas-batas berbagai bentuk dan luasan atau dikenal 

sebagai wilayah studi atau dikenal dengan istilah populer 

“Area of Interest (AOI)”. Masing-masing scene citra yang 

tersedia bisa saja melebihi kebutuhan AOI namun terdapat 

juga luasan AOI yang membutuhkan gabungan beberapa scene  

untuk penyelesaian pekerjaan analisis sehingga dibutuhkan 

tindakan yang penggabungan yang populer dengan istilah 

“Mosaic Scene”. 

Mosaic scene secara mudah dapat dikerjakan dengan 

menggabungkan beberapa scene yang berdekatan agar dapat 

meliputi AOI menggunakan bantuan perangkat lunak 

pemetaan. Langkah-langkah melakukan mosaic scene 

diuraikan dibawah ini. 

Misal kita akan melakukan kegiatan mosaic scene citra landsat 

8 untuk wilayah Provinsi Jakarta dan sekitarnya (lokasi dalam 

tanda kotak pada gambar) yang membutuhkan dua scene yaitu: 

1) Scene pada Path 122 dan Row 064; 2) Scene pada Path 122 

dan Row 065. 
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a. Melakukan pengunduhan citra yang dibutuhkan. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Gambar Scene pada Path 122 dan Row 064. 
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Gambar Scene pada Path 122 dan Row 065. 

 

b.  Mengunggah kedua citra kedalam perangkat lunak dengan 

menarik file citra langsung dari explorer atau menggunakan 

fitur “Add Raster Layer” seperti 
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c. Tampilan citra yang sudah terunggah. Tampak kedua citra     

    saling menumpuk dengan irisan antar scene citra berwana  

    hitam. 

 

 

 

 

 

 

 

 

 

 

 

 

 

d. Menggabungkan citra dengan fitur “Merge” dengan 

mengklik pada menu: “Raster” > “Miscellaneous” > 

“Merge…” dan menunggu proses berjalan beberapa saat 

tergantung spesifikasi komputer. 
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Pengguna tinggal mengunggah file yang akan 

digabungkan dan menentukan file hasil. Opsi “No data 

value” harus diisi dengan angka “0” sehingga daerah yang 

tidak memiliki jejak data atau tampak berwarna hitam akan 

dihilangkan pada file hasil penggabungan. Citra sebelum 
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dan sesudah penggabungan dapat dilihat pada gambar 4.1 

dibawah ini. 

 

 

 

 

 

 

 

 

 

 

 

Gambar 4.1. Proses Mosaic: Citra Sebelum dan Sesudah 

Proses 

 

Setelah dilakukan mosaic atau penggabungan scene 

maka citra landsat 8 yang awalnya terpisah-pisah sesuai 

scene akan tergabung menjadi hanya satu scene dan “gap” 

atau irisan citra berwarna hitam akan menghilang dan 

menumpuk sesuai dengan kondisi sesungguhnya. 

 

C.4. Clipping  

Kegiatan analisis spasial seringkali dilakukan pada AOI 

dengan luasan lebih kecil dibandingkan satu scene atau sudah 

Sebelum Mosaic Hasil Mosaic 
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terliputi dalam satu gabungan scene. Masing-masing scene 

citra yang tersedia bisa saja melebihi kebutuhan AOI sehingga 

untuk mengatasi permasalahan tersebut dibutuhkan tindakan 

yang disebut “Clipping”. 

Tindakan clipping dapat dilakukan secara mudah dengan 

bantuan perangkat lunak sehingga citra yang masih mencakup 

areal yang luas dapat diperkecil hanya sesuai AOI yang 

diinginkan. Dengan tindakan clipping maka data yang tidak 

diinginkan dapat disingkirkan dan kegiatan hanya berfokus 

pada AOI yang direncanakan. 

Citra hasil mosaic pada contoh di bagian 3 (Mosaic Scene) 

akan dipotong seluas Provinsi Jakarta menggunakan data 

vektor wilayah Provinsi Jakarta berdasarkan peta dasar 

BAKOSURTANAL skala 1:250.000. Hasil akhir tindakan 

clipping adalah citra Landsat 8 Provinsi DKI Jakarta. 

Langkah-langkah pengerjaan diuraikan dibawah ini. 

a. Mengunggah data vektor peta batas wilayah provinsi format   

    shapefile (*.shp) kedalam jendela kerja Qgis 2.18. 

 

 

 

 

 

 

 

Batas Wilayah 

Provinsi DKI 

Jakarta 
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0 

 

Tampilan peta batas wilayah Provinsi DKI Jakarta pada 

jendela kerja Qgis 2.18. 

 

 

 

 

 

 

 

 

b. Menjalankan fitur “Clipper” dengan mengklik pada menu:  

    “Raster” > “Extraction” > “Clipper…” 
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c. Menjalankan fitur “Clipper” dengan mengklik pada menu:  

   “Raster” > “Extraction” > “Clipper…” 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Mengisi pada opsi “Input file”, “Output file”, “No data 

Value dan “Clipping Mode”. Khusus pada opsi “Clipping 

Mode” maka pilih pada “Mask Layer” dan pilih file batas 

wilayah yang sudah diunggah diawal.  

Klik tombol “Ok” untuk menjalankan fitur dan tunggu 

beberapa saat. 
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d.  Hasil Clipping akan tampil pada jendela kerja diman citra 

landsat 8 akan terpotong sesuai dengan batas-batas wilayah 

Provinsi DKI Jakarta 
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C.5. Kombinasi Band 

Kombinasi Band merupakan istilah umum untuk kegiatan 

yang dilakukan praktisi penginderaan jauh untuk 

menyesuaikan pewarnaan yang merepresentasikan kecerahan 

pada bagian-bagian spektrum citra yang berbeda (Campbell 

dan Wynne, 2011). Pada aplikasinya untuk beberapa macam 

citra satelit, kombinasi band dilakukan dengan 

menggabungkan beberapa band (saluran citra dengan rentang 

spektrum elektomagnetik tertentu) dengan kombinasi 

spektrum tertentu menjadi hanya satu citra.  

Sebagai contoh pada citra Landsat 8 terdapat beberapa 

band. Dari 11 band hanya band 1 sampai 4 dengan panjang 

gelombang terpendek yang merupakan sinar tampak 

sedangkan sisanya merupakan spektrum tidak tampak (tidak 

dapat dilihat manusia. Hanya separuh cahaya tangkapan pada 

citra Landsat yang dapat dilihat oleh mata manusia (Barsi et 

al., 2014). Rincian band pada Landsat 8 dapat dilihat pada 

tabel dibawah ini. 

Tabel 4.1. Rincian Band pada Citra Landsat 8 OLI TIRS 

Bands 
Wavelength Resolution 

(micrometers) (meters) 

Band 1 - Ultra Blue (coastal/aerosol) 0.435 - 0.451 30 

Band 2 - Blue 0.452 - 0.512 30 

Band 3 - Green 0.533 - 0.590 30 

Band 4 - Red 0.636 - 0.673 30 

Band 5 - Near Infrared (NIR) 0.851 - 0.879 30 
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Contoh Kombinasi Band 5,4 dan 3 pada citra Landsat 8 

(kode  file: LC08_L1TP_124061_20150626_20170407 

_01_T1),  dapat dilihat pada gambar dibawah ini. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Band 6 - Shortwave Infrared (SWIR) 1 1.566 - 1.651 30 

Band 7 - Shortwave Infrared (SWIR) 2 2.107 - 2.294 30 

Band 8 - Panchromatic 0.503 - 0.676 15 

Band 9 - Cirrus 1.363 - 1.384 30 

Band 10 - Thermal Infrared (TIRS) 1 10.60 - 11.19 100 * (30) 

Band 11 - Thermal Infrared (TIRS) 2 11.50 - 12.51 100 * (30) 

Band 5 Band 4 Band 3 

Composite Band 
5,4,3 
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Gambar 4.2. Skema Kombinasi Band 

 

C.6. Pan sharpening  

Pan sharpening atau dapat diartikan sebagai penajaman 

citra adalah tindakan yang dilakukan untuk memperbaiki 

resolusi spasial citra yang akan dijadikan sebagai bahan 

analisis. 

Sebagai contoh apabila kita ingin melakukan analisis 

perubahan penggunaan lahan di Provinsi Jawa Tengah dengan 

data yang tersedia berupa citra Landsat 8. Setelah menelaah 

keterangan teknis citra Landsat diketahui bahwa setiap band 

atau saluran spektral memiliki resolusi 30 meter dan terdapat 

band panchromatic 15 meter pada scene yang sama. band 

panchromatic 15 meter memberikan kemungkinan untuk 

melakukan Kombinasi Band dengan hasil akhir citra 

beresolusi 15 meter sehingga menghasilkan pembacaan 

analisis yang lebih baik. 

 

D. Rangkuman 

1. Koreksi geometrik adalah perlakuan untuk memperbaiki 

posisi geografis citra sehingga ketepatan lokasi pada citra 

sesuai dengan lokasi sebenarnya secara geografis.  

2. Koreksi geometrik diperlukan pada citra akuisisi lama,  

citra bentuk digital format non referensi geografis, hasil 

scan peta cetak maupun foto udara.  
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3. Koreksi Radiometrik merupakan tindakan yang dilakukan 

untuk mengkoreksi nilai piksel pada citra karena 

dimungkinkan terjadinya penyimpangan akibat gangguan 

sensor, atmosfer, transfer data atau saat dilakukan konversi 

data.  

4. Mosaic scene adalah penggabungan beberapa scene untuk 

menyesuaikan kebutuhan lokasi analisis. 

5. Clipping adalah kegiatan analisis spasial berupa pemotong-

an scene sehingga citra hanya menunjukkan area sesuai 

dengan kebutuhan wiayah penelitian saja. 

6. Kombinasi Band dapat diartikan sebagai penggabungan 

beberapa band menjadi hanya satu citra multispectral. 

7. Pan sharpening dapat diartikan sebagai penajaman citra 

adalah tindakan yang dilakukan untuk memperbaiki resolu-

si spasial citra yang akan dijadikan sebagai bahan analisis. 

 

E.  Pertanyaan Dan Evaluasi  

1. Apakah urgensi melakukan koreksi geografis? 

2. Perlukan koreksi geografis untuk citra Landsat 8? Jelaskan 

alasannya? 

3. Jelaskan cara untuk memperbaiki citra yang kualitasnya 

kurang baik akibat kerusakan pada sensor! 

4. Jelaskan tahapan untuk mendapatkan citra lokasi penelitian 

Kecamatan Kedaton dari sumber data citra Provinsi Lam-

pung! 
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5. Jelaskan tahapan untuk mendapatkan citra multispekral 

untuk analisis kenampakan alur sungai di Kabupaten 

Pesisir Barat! 
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CEK PENGUASAAN MATERI 

 

Dalam rangka mengetahui kemampuan awal peserta didik 

terhadap materi pembelajaran, berikut ini tersedia daftar 

pertanyaan yang harus dijawab: 

 

Jawablah pertanyaan di bawah ini sesuai dengan yang Anda 

ketahui. 

1. Apa yang dimaksud dengan kombinasi band? 

2. Apa fungsi kombinasi band dalam analisis penginderaan 

jauh? 

3. Band berapa saja yang digunakan untuk interpretasi NDVI 

4. Apa yang dimaksud dengan klasifikasi terbimbing? 

5.  Apa yang dimaksud dengan klasifikasi tidak terbimbing? 
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BAB V 

ANALISIS PENGINDERAAN JAUH 

 

A. Identitas Mata Kuliah 

Fak/Jur : Pertanian / Kehutanan  

 Mata Kuliah : Penginderaan Jauh Untuk 

Kehutanan 

 Kode Mata Kuliah  : KHT 612101 

 Jumlah SKS : 3 (2-1) SKS 

 Semester / pertemuan 

ke 

: 5 / pertemuan ke 5-10 

Pokok Bahasan : Persiapan Citra Penginderaan 

Jauh 

 

B. Capaian Dan Indikator 

I. Capain Pembelajaran 

 Mahasiswa dapat menjelaskan dan melakukan rangkaian 

tindakan:  

1. Kombinasi band untuk kebutuhan analisa 

2. Kombinasi band false color untuk interpretasi badan 

air. 

3. Kombinasi band false color untuk interpretasi NDVI. 

4. Analisa penggunaan lahan dengan klasifikasi 

terbimbing dan tidak terbimbing. 

II. Indikator Capain Pembelajaran 
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 Setelah mengikuti perkuliahan mahasiswa dapat:  

1. Kombinasi band untuk kebutuhan analisa 

2. Kombinasi band false color untuk interpretasi badan 

air. 

3. Kombinasi band false color  untuk interpretasi NDVI. 

4. Analisa penggunaan lahan dengan terbimbing dan 

tidak terbimbing. 

 

C. Macam Kombinasi Band 

C.1. Kombinasi band untuk kebutuhan analisa 

Citra satelit terbagi atas beberapa band yang dibuat untuk 

memudahkan pengguna melakukan analisis dengan spesifikasi 

objek penelitian berbeda. Perkembangan dan peningkatan 

teknologi sensor terus dikembangkan untuk meningkatkan 

kemampuan tangkapan sensor, tidak hanya peningkatan 

resolusi gambar tetapi juga kedalaman, kualitas dan kompresi 

gambar. 

Perbedaan komposisi band yang dikombinasikan 

memudahkan pengguna melakukan analisis untuk 

interpretasikan kondisi sesungguhnya dari objek penelitian. 

Pada tabel Tabel 5.1 Jenis dan Komposisi Band pada Citra 

Landsat 8 (USGS, 2018) dalam bab 4 telah dijelaskan 

beberapa jenis kombinasi dan kombinasi band yang biasa 

digunakan untuk identifikasi spesifik. 
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Tabel 5.1 Macam Kombinasi Band Pada Citra Landsat 7 dan 8 

(USGS, 2018) 

Jenis Kombinasi 

Komposisi Citra 

Landsat 7 

Landsat 5 
Landsat 8 

 

Color Infrared 4, 3, 2 5,4,3 

 

Natural Color 3, 2, 1 4,3,2 

 

False 

Color 
5,4,3 6,5,4 

 

False 

Color 
7,5,3 7,6,4 

 

False 

Color 
7,4,2 7,5,3 
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Kombinasi band yang akan diuraikan langkah pengerjaannya 

pada bab ini antara lain adalah kombinasi band false color 

untuk interpretasi badan air dan kombinasi band false color 

untuk interpretasi NDVI (Net difference vegetation index). 

Rangkaian pekerjaan akan menggunakan data hasil pekerjaan 

pada bab 4 yang sudah melalui tahapan persiapan awal 

(preprocessing). 

 

C.2. Tahapan Melakukan Kombinasi Band 

Pada bab ini, bahan kegiatan menggunakan citra 

Landsat 8 OLI TIRS untuk scene pada path 124 dan row 061 

yang diakuisisi tanggal 26 juni 2015 dengan nama file 

PAN_LC08_L1TP_124061_20150626_ 20170407_ 01_T1. 

Citra tersebut sudah melalui tahap persiapan awal 

(preprocessing) berupa koreksi radiometrik dan penajaman 

(pan sharpening). Langkah melakukan kombinasi band 

menggunakan perangkat lunak Qgis 2.18 diuraikan dibawah 

ini. 

a. Membuka QGIS 2.18. Menggunggah file raster citra 

Landsat 8 untuk kombinasi band 4,3 dan 2 melalui 

“Browser Panel” atau icon “Add Raster Layer”. 
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b. Data akan ditampilkan pada “Layers Panel”. 

 

 

 

 

 

 

c. Melakukan tindakan kombinasi band untuk kombinasi band  

    4-3-2. Pada toolbar, pilih “Raster” > pilih “Miscellaneous”  

    > pilih “Build Virtual Raster (Catalog)…” 
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d. Akan tampil jendela “Build Virtual Raster” dengan pilihan- 

    pilihan.  

 

 

 

 

 

 

 

 

 

 

 

Centang pada opsi “Use visible raster layers for input” 

karena sebelumnya kita hanya menggungah file yang 

dibutuhkan saja atau gunakan kolom “Input files” untuk 

memilih file-file tertentu dari komputer.  
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Isi kolom “File output” untuk menentukan lokasi dan nama  

file yang akan dihasilkan. 

 

 

 

 

 

 

 

 

 

 

 

 

e. Hasil kombinasi band 4-3-2 (true color) 
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D. Contoh Kombinasi Band 

Macam kombinasi band telah dijelaskan pada sub bab 

sebelumnya dengan contoh kombinasi yang dapat dilakukan 

pada citra satelit Landsat 8. Pada citra satelit jenis lain juga 

dapat dilakukan kombinasi serupa dengan memperhatikan 

rentang gelombang elektromagnetik yang ditangkap oleh 

sensor satelit tersebut. 

Kombinasi band yang diterangkan pada buku ini adalah 

kombinasi band untuk mengenali bagian-bagian yang 

merupakan badan air seperti sungai, waduk, kolam, rawa dan 

lain sebagainya serta pengenalan kerapatan vegetasi yang 

diamatai berdasarkan rentang nilai indeks dari perhitungan 

NDVI yang terbaca dari citra. 

D.1. Pengenalan Badan Air 

Bahan citra yang digunakan pada bagian pengenalan badan 

air sama dengan file pada latihan kombinasi band yaitu citra 

Landsat 8 OLI TIRS untuk scene pada path 124 dan row 061 

yang diakuisisi tanggal 26 juni 2015 dengan nama file 

PAN_LC08_L1TP_124061_20150626_ 20170407_ 01_T1. 

Citra tersebut sudah melalui tahap persiapan awal 

(preprocessing) berupa koreksi radiometrik dan penajaman.  
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a. Membuka QGIS 2.18. Menggunggah file raster citra 

Landsat 8 untuk kombinasi band 7,5 dan 3 melalui 

“Browser Panel” atau icon “Add Raster Layer” 

 

 

b. Data akan ditampilkan pada “Layers Panel”. 

 

 

 

 

 

c. Melakukan tindakan kombinasi band untuk kombinasi band  

    7-5-3. Pada toolbar, pilih “Raster” > pilih “Miscellaneous”  

    > pilih “Build Virtual Raster (Catalog)…” 
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d. Akan tampil jendela “Build Virtual Raster” dengan pilihan- 

    pilihan.  

 

 

 

 

 

 

 

 

 

 

 

 

Centang pada opsi “Use visible raster layers for input” 

karena sebelumnya kita hanya menggungah file yang 

dibutuhkan saja atau gunakan kolom “Input files” untuk 

memilih file-file tertentu dari komputer.  
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Isi kolom “File output” untuk menentukan lokasi dan nama  

file yang akan dihasilkan. 

 

 

 

 

 

 

 

 

 

 

 

e. Hasil kombinasi band 4-3-2 (true color) dengan band 7-5-3  

    (false color) 

 

 

 

 

 

 

 

 

 

  

Band 4-3-2 

Band 7-5-3 
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D.2. Pengenalan Kerapatan Vegetasi 

Teknik pengenalan vegetasi menggunakan kombinasi band 

dapat dilakukan menggunakan beberapa teknik namun yang 

paling populer digunakan adalah dengan metode  NDVI atau 

Normalized Difference Vegetation Index (NDVI). Lillesand 

dan Kiefer  (1997) menyebutkan bahwa Indeks vegetasi atau 

NDVI adalah indeks yang menggambarkan tingkat kehijauan 

suatu tanaman. Dimana untuk mendapatkan nilai indeks 

vegetasi yang memiliki rentang dari -1 sampai 1 diperlukan 

perhitungan antara band merah dan band NIR (Near-Infrared 

Radiation).  

Rumus NDVI adalah: 

NDVI    =     (NIR – Red) / (NIR+Red) 

Dimana : 

NIR= band radiasi  inframerah 

Red= band radiasi cahaya merah tampak  

 

Bahan citra yang digunakan pada bagian pengenalan badan 

air sama dengan file pada latihan kombinasi band pada bagian 

sebelumnya yaitu citra Landsat 8 OLI TIRS untuk scene pada 

path 124 dan row 061 yang diakuisisi tanggal 26 juni 2015 

dengan nama file PAN_LC08_L1TP_124061_20150626_ 

20170407_ 01_T1. Langkah-langkah pengerjaan diuraikan 

dibawah ini.  
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a. Membuka QGIS 2.18. Menggunggah file raster citra 

Landsat 8 untuk kombinasi band 5 dan 4 melalui “Browser 

Panel” atau icon “Add Raster Layer”. Pada citra Landsat 7 

maka kombinasi band  yang digunakan adalah band 4 dan 

3. 

 

 

b. Data akan ditampilkan pada “Layers Panel”. 

 

 

 

 

 

 

c. Membuka “Raster Calculator” pada menu “Raster”. 
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d. Jendela “Raster Calculator” akan terbuka dan lakukan 

pengisian pada bagian “Output Layer” dengan nama file 

baru yang akan dihasilkan. Pada latihan ini diberi nama file 

NDVI#1. 

 

 

 

 

 

 

 

  

Isi kolom “File name” dengan nama file yang diinginkan. 
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e. Beralih ke bagian “Raster Calculator Expression” dan 

mengisi rumus pada kolom dengan memilih dengan klik 

kiri pada mouse dengan pilihan di bagian “Raster Bands” 

dan tombol-tombol di bagian “Operators”. 
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Gambar bagian bagian “Raster Bands” dan “Operators”. 

 

 

 

 

 

 

 

 

 

 

 

 

Kombinasikan dengan klik pada mouse sehingga akan 

terbentuk rumus: 

 

 

 

 

 

  

("PAN_LC08_L1TP_124061_20150626_20170407_01_T1_B5@1" - 

"PAN_LC08_L1TP_124061_20150626_20170407_01_T1_B4@1") / 

("PAN_LC08_L1TP_124061_20150626_20170407_01_T1_B5@1" + 

"PAN_LC08_L1TP_124061_20150626_20170407_01_T1_B4@1")  



V-18 | A n a l i s i s  P e n g i n d e r a a n  J a u h  

 

f. Klik tombol “Ok” dan tunggu sampai proses selesai dan 

muncul layer “NDVI#1” pada bagian “Layer Panel”. 

 

 

 

 

 

 

 

 

 

 

 

 

 

g. Perhatikan nilai pada bagian “Layer Panel” yang  

menunjukkan angka – 0.508231 pada bagian atas dan 

0.874868 pada bagian bawah. Angka tersebut menunjukkan 

rentang indeks NDVI yang terbaca pada scene yang 

dianalisis. 
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h. Melakukan teknik coloring untuk mendapatkan visualisasi 

warna nampak perbedaan nilai NDVI yang terbaca pada 

masing-masing tempat.  

Arahkan mouse menuju layer panel dan klik kanan pada 

layer NDVI#1 sehingga muncul pilihan. Klik pada opsi 

“Properties” hingga muncul jendela pilihan “Layer 

Properties”. 
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i. Klik pada opsi “Style” > pilih  Render type dengan “Singleband pseudocolor” 

        Pilih Interpolation dengan “Linier” 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

1 

2 



V-21 | A n a l i s i s  P e n g i n d e r a a n  J a u h  

 

j. Pada bagian Mode pilih “Continous” dan klik pada tombol “Classify” dan akan muncul nilai  

yang secara otomatis (nomor 3) terbagi menjadi 5 kelas sesuai setingan standar dari perangkat 

  lunak Qgis. Klik tombol “Ok” dibagian bawah jendela dan tunggu beberapa saat. 

 

 

 

 

 

 

 

 

 

 

 

 

 

1 

3 

2 
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k. Tampilan layer akan berubah warna sesuai nilai indeks. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

Sebelum 

Sesudah 

Zoom 
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l. Merubah rentang indeks sehingga pewarnaan menginter-  

      pretasikan kerapatan vegetasi (Putra, 2011 dalam Santoso 

et  

 al., 2017). 

Tabel 5.2. Kriteria dan Jenis Tutupan Lahan Berdasarkan 
Kisaran Nilai Indeks NDVI 

 

Keterangan dari layer tersebut adalah nilai NDVI terendah 

terbaca adalah - 0.508 dan tertinggi 0.875(nomor 1). Rubah 

rentang nilai menjadi: -0.508; 0; 0,3; 0,5 dan 0,875 (nomor 2). 

 

 

 

 

 

 

 

 

 

No. Kisaran Nilai 

NDVI 

Kriteria 

Kerapatan 

Vegetasi 

Jenis  

Tutupan 

 Lahan 

1 - 1 s/d 0 Tidak 

Bervegetasi 

Embung, 

Awan 

2 > 0 s/d 0,3 Tidak Rapat Tanaman 

Pertanian 

3 > 0,3 s/d 0,5 Cukup Rapat Pekarangan, 

Gelam, Pohon 

4 > 0,5 Rapat Karet, Gelam, 

Pohon Besar 

1 

2 
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m. Tampilan layer akan berubah warna sesuai nilai indeks 

yang  

       baru. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Perubahan terjadi pada beberapa tempat namun hal tersebut 

akan diketahui lebih jelas secara kuantitatif dengan 

menghitung luasan pada masing-masing rentang nilai 

indeks dengan melakukan tindakan “Reclassify” yang akan 

dijelaskan pada bagian selanjutnya. 

 

Sebelum 

Sesudah 
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E. Analisis Penggunaan Lahan  

Penggunaan lahan merupakan hal-hal fisik yang ada diatas 

permukaan tanah. Penggunaan lahan berbeda-beda antara satu 

tempat dengan tempat lainnya karena dipengaruhi berbagai 

faktor, baik faktor ekonomi, politik, budaya maupoun sosial. 

Sampurno dan Thoriq (2016) menyatakan bahwa 

penggunaan lahan dapat menggambarkan keterkaitan antara 

proses alami dan proses sosial. Penggunaan lahan dapat 

diamati dan dianalisis  menggunakan teknologi penginderaan 

jauh untuk beragam tujuan.  

Penggunaan lahan sering diamati terutama untuk 

mengetahui perubahan-perubahan yang terjadi pada kisaran 

waktu tertentu. Hal ini dilakukan untuk dengan mengamati 

rekaman citra sesuai urutan waktu dengan tujuan mengetahui 

sejarah, perkembangan dan perubahan yang terjadi sehingga 

dapat menjadi melakukan simulasi atau pemodelan. Analisis 

perubahan penggunaan lahan sering dilakukan dalam bidang 

kehutanan dan menjadi salah satu dasar pengambilan 

kebijakan oleh pemangku kepentingan. 

Teknik analisis penggunaan lahan dapat dilakukan 

klasifikasi citra dengan melakukan pengelompakan terhadap 

informasi spektral yang terkandung dalam citra tersebut. 

Lillesand et al. (2008) menyatakan Tujuan keseluruhan 

prosedur klasifikasi gambar adalah secara otomatis 
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mengkategorikan semua piksel pada sebuah citra k dalam 

kelas atau tema penggunaan lahan.  

Teknik populer dan paling sering dilakukan terutama pada 

citra Landsat 8 dengan batasan resolusi spasial yang dimiliki 

adalah dengan klasifikasi citra yang berbasis pada 

pengelompokan nilai piksel pada citra, yaitu: 

1. Klasifikasi tidak terbimbing (tidak terbimbing 

classification). 

2. Klasifikasi terbimbing (terbimbing classification). 

E.1. Klasifikasi Tidak Terbimbing 

Prinsip dari teknik klasifikasi tidak terbimbing adalah 

penggunaan algoritma klasterisasi secara otomatis yang 

tersimpan dalam fungsi (menu) perangkat lunak sehingga nilai 

piksel dari citra yang terbaca akan dikelompokkan sesuai 

jumlah kelas atau klaster yang diinginkan. Teknik ini tidak 

disarankan digunakan sebagai dasar utama penentuan kelas 

penggunaan lahan terutama untuk cakupan wilayah yang luas 

karena tingkat akurasi yang rendah dan kemungkinan 

kesalahan pembacaan sangat tinggi. 

Analisis penggunaan lahan menggunakan bahan berupa 

citra satelit Landsat 8 dilaksanakan melalui serangkaian 

tahapan seperti pada kegiatan yang telah dibahas sebelumnya. 

Hasil dari analisis penggunaan lahan berupa jenis-jenis 

penggunaan lahan beserta luasannya. Apabila analisis 

dilakukan pada rangkaian yang berbeda-beda maka dapat 
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diamati rangkaian perubahan-perubahan jenis penggunaan, 

luasan dan lokasi yang terjadi.  

Langkah-langkah melakukan klasifikasi tidak terbimbing 

dijelaskan pada uraian dibawah ini. 

a. Siapkan citra satelit yang akan dianalisis dan tentukan area 

penelitian yang diinginkan. 

 

 

 

 

b. Buka perangkat lunak Qgis. Klik “Project” > “New”. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

a. BDL_KEC.shp  https://goo.gl/GcY2qy 

b. L1_CLIP_BDL   

https://goo.gl/GcY2qy
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c. Menyimpan pekerjaan kedalam sebuah project. Klik icon 

“Save As”. Beri nama project anda, pada latihan ini nama 

project adalah “PENGGUNAAN LAHAN#1”. 
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d. Unggah file citra sebagai bahan pekerjaan. File yang 

diperlukan adalah: a) L#1_CLIP_BDL.tiff dan b) 

BDL_KEC.shp. 
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e. Pada Qgis 2.18, kegiatan klasifikasi tidak terbimbing tidak 

dapat dilakukan untuk citra multiband/Kombinasi 

bandsehingga harus dilakukan modifikasi dimana citra 

dibagi terlebih dahulu. Buka citra bahan “ menu “Raster” > 

“Raster Calculator”. 

 

 

 

 

 

 

 

 

 

 

f. Pada jendela “Raster Calculator”. Klik ganda pada band 

“L#1_CLIP_BDL@1” pada segmen “Raster bands” hingga 

muncul tampilan pada “Raster calculator expression” 

kemudian isi “Output layer” dan “Output format” dan klik 

pada tombol “Ok”. ulangi tindakan tersebut untuk dua file 

lainnya. 
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g. Tampilan pada jendela “Layer Panel” 
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h. Buka Processing Tollbox dan cari pilihan “K-means 

clustering for grids” kemudian klik ganda sehingga 

muncul jendela baru. 

 

 

 

 

 

 

 

 

i. Pada jendela “K-means clustering for grids” lakukan 

pengisian pada kolom dibawah ini. Centang citra 1,2 dan 3 

kemudian klik tombol “Ok”. Pilih opsi “[2] Combined 

Minimum Distance/Hillclimbing” pada segmen “Method”. 

Merubah jumlah “Cluster” menjadi 5 (atau sesuai jumlah 

kelas penggunaan lahan yang diinginkan).  
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10. Klik “Run” dan tunggu beberapa saat. 

 

 

 

 

 

11. Tunggu hingga hasil pengolahan dihasilkan dan 

ditampilkan pada jendela utama.  
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12. Lakukan teknik “Coloring” untuk merubah tampilan warna 

pada citra. Klik kanan pada Layer: Clusters  kemudian  

pilih “Properties”. 

 

 

 

 

 

 

 

13. Pada pilihan “Style”, pilih “Singleband pseudocolor” dan 

“Mode: Equal interval” kemudian klik tombol “+” pada 

menu Classify sehingga ditampilkan opsi pewarnaan. Klik 

tombol “Ok”.  
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Hasil pewarnaan 
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14. Tampilan pada perangkat lunak Qgis yang sudah dilakukan pewarnaan citra. Warna yang sama 

menunjukkan bahwa area tersebut memiliki besaran nilai piksel yang secara statistik masuk dalam 

kelompok kelas/Cluster yang sama dan secara spasial merepresentasikan suatu penggunaan lahan yang 

sama, misalnya penggunaan lahan tersebut dapat berupa: Jalan, Air, Tutupan Awan, Pemukiman atau 

Vegetasi. 

 

 

 

 

 

 

 

 

 



V-37 | A n a l i s i s  P e n g i n d e r a a n  J a u h  

 

E.2. Klasifikasi Terbimbing 

Pada teknik klasifikasi terbimbing, pengguna terlibat dalam 

menentukan area contoh sampel (training sample) masing-

masing jenis kelas penggunaan lahan sehingga besaran nilai-

nilai pikselnya akan digunakan perangkat lunak untuk 

mengenali dan mengelompokkan area-area dalam cakupan 

nilai piksel serupa sesuai kelas yang diinginkan.  

Langkah-langkah melakukan klasifikasi terbimbing 

(Terbimbing Classifications) dijelaskan pada uraian dibawah 

ini.  

1. Instal plugin tambahan untuk memudahkan pekerjaan. Klik 

menu “Plugins” > “Manage and Install Plugins…”.  

 

 

 

 

 

 

2. Pilih plugin “Semi-Automatic Classification Plugin” atau 

SCP dengan mengetik pada kolom “Search”. Kemudian 

klik tombol “Install Plugin” > Klik “Ok” dan plugin akan 

melakukan penginstalan pada sistem utama. 
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3. Mengunggah file bahan kedalam jendela utama. File bahan 

bisa didapatkan dari tautan berikut: 

 

 

 

 

 

 

File CLPPAN1_5 METER.tiff (resolusi spasial 5 meter): 

a. https://goo.gl/SNe4gR 

b. https://goo.gl/g6vZaE 
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4. Aktifkan “SCP Dock” dengan klik kanan pada bagian 

toolbar dan centang pada opsi “SCP Dock”. 

 

 

 

 

 

 

 

 

 

 

5. Masukkan file “CLPPAN1_5.tiff pada segmen “Input 

image” dan pada segmen “Training input” buatlah file baru  

“Training sampel.scp”. 
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6. Klik pada segmen “Classification dock” dan tampilan akan 

berubah seperti pada gambar dibawah ini. 

 

 

 

 

 

 

 

 

 

 

 

 

7. Teknik Terbimbing classification atau klasifikasi terbimbing 

membutuhkan contoh besaran piksel dari wilayah dengan 

kelas penggunaan lahan tertentu sebagai dasar perhitungan 

melakukan pembagian kelas penggunaan lahan secara luas 

sesuai AOI. Contoh wilayah tersebut dikenal dengan istilah 

ROI (Region Of Interest).  

Sampel ROI dimasukkan dalam file training sampel.scp 

dengan cara mengklik pada icon            “Create a ROI 

poligon” pada toolbar bagian atas. 
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Klik sekali pada icon kemudian seleksi wilayah kelas yang 

dapat mewakili kelas penggunaan lahan tertentu sehingga 

membentuk poligon, kemudian klik kanan untuk menutup 

bentuk poligon tersebut. 

 

 

 

 

 

 

 

 

 

 

8. Poligon akan terekam dalam “ROI Signature list”. Pada 

segmen ROI creation lakukan penyimpanan keterangan 

ROI tersebut. MC ID adalah ID kelas induk (Macroclasses) 

dan C ID adalah ID kelas. Dalam sebuah MC ID dapat 

memuat kelas-kelas. Sedangkan MC Info adalah 

keterangan atau nama kelas induk dan C Info adalah nama 

kelas. Misal, pada MC ID: 5 dan MC Info: Terbangun, 

dapat diisi 

C ID C Info 

5 Tanah Terbuka 

6 Pemukiman 
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7 Industri 

Klik pada icon “Calculate sig.” untuk menyimpan poligon 

dan keterangannya. 

 

 

 

 

 

 

 

 

 

 

 

 

9. Peningkatan kecermatan pengenalan kelas penggunaan 

lahan dapat dilakukan dengan menambahkan Layer citra 

lain dan mengatur transparansinya. 

Instal Plugin: “OpenLayers plugin” seperti pada contoh 

no.1. Buka menu “Web” > “OpenLayers plugin” > “Google 

Maps” > Google Satellite”.  
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Klik kanan pada Layer dan pilih Properties. 
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Masuk pada opsi “Trasnparency” dan atur persentase kira-kira 

60 sampai 80% sehingga tampilan pada jendela utama mudah 

untuk dilakukan pengamatan. 

 

 

 

 

 

 

 

Contoh tampilan layer yang dihasilkan. 

 

 

 

 

 

 

 

 

 

10. Klik pada segmen “Macroclasses” dan lakukan 

pengecekan kelas penggunaan lahan yang sudah tersimpan. 

11. Klik pada segmen “Classification algorithm”. Pengguna 

dapat memilih menggunakan MC ID atau C ID sebagai 
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basis jumlah kelas penggunaan lahan yang akan dilakukan. 

Pada latihan ini pilih C ID dan “Maximum likelihood”. 

 

 

 

 

 

 

 

 

 

12. Klik pada icon “Run” untuk menjalankan klasifikasi. 

Jendela penyimpanan akan mucul dan beri nama pada file 

yang akan dihasilkan. Misal “SC_BDL”. Tunggu perangkat 

bekerja. 
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13. File hasil pengkelasan akan ditampilkan pada jendela 

utama.  

 

 

 

 

 

 

 

 

14. Perubahan warna pada masing-masing kelas penggunaan 

lahan dapat dilakukan pada Layer properties. Klik kanan 

pada Layer “SC_BDL” dan pilih pada opsi Style. Klik 

ganda pada icon di kolom  Color dan lakukan penyesuaian 

sesuai keinginan. 
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F. Rangkuman 

1. komposisi band yang dikombinasikan disesuaikan dengan 

analisis atau interpretasi yang akan dilaksanakan.  

2. Kegiatan kombinasi band dilakukan setelah citra koreksi 

radiometrik dan penajaman (pan sharpening).  

3. Pengenalan badan air dapat dilakukan dengan melakukan 

kombinasi citra dengan komposisi band 7,5 dan 3. 

4. Kerapatan vegetasi dapat dilakukan dengan melakukan 

dengan metode  NDVI atau Normalized Difference 

Vegetation Index (NDVI). 

5. NDVI membandingkan nilai antara antara band merah dan 

band NIR (Near-Infrared Radiation) dengan rumus: NDVI 

= (NIR – Red) / (NIR+Red) 

6. Rentang nilai indeks NDVI adalah -1 sampai 1. 

7. Analisis penggunaan lahan dapat dilakukan dengan teknik 

klasifikasi terbimbing dan tidak terbimbing. 

8. Klasifikasi tidak terbimbing menggunakan algoritma 

klasterisasi dalam fungsi (menu) perangkat lunak sehingga 

nilai piksel dari citra yang terbaca akan dikelompokkan 

sesuai jumlah kelas atau klaster yang diinginkan.  

9. Teknik klasifikasi tidak terbimbing tidak cock untuk 

wilayah analisis yang luas karena tingkat akurasi yang 

rendah dan kemungkinan kesalahan pembacaan sangat 

tinggi. 
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10. Klasifikasi Terbimbing dilaksanakan dengan keterlibatan 

pengguna dalam menentukan area contoh sampel (training 

sample) yang merepresentasikan nilai piksel untuk masing-

masing jenis kelas penggunaan lahan tertentu.  

11. Pengecekan lapangan tetap diperlukan sebagai verifikasi 

penggunaan lahan sebenarnya sekalipun peneliti 

menggunakan citra dengan resolusi sangat tinggi. 

 

G. Pertanyaan Dan Evaluasi  

1. Tuliskan rumus NDVI! 

2. Berapakah rentang nilai indek NDVI? 

3. NDVI membandingkan nilai pantulan dari band apasaja? 

4. Teknik klasifikasi mana yang lebih tepat digunakan pada 

analisis perubahan penggunaan lahan di Pulau Pahawang? 

Jelaskan! 

5. Teknik klasifikasi mana yang lebih tepat digunakan pada 

analisis perubahan penggunaan lahan di Kabupaten Jayapu-

ra? Jelaskan! 
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CEK PENGUASAAN MATERI 

 

Dalam rangka mengetahui kemampuan awal peserta didik 

terhadap materi pembelajaran, berikut ini tersedia daftar 

pertanyaan yang harus dijawab. Jawablah pertanyaan di bawah 

ini sesuai dengan yang Anda ketahui. 

1. Hasil analisis penginderaan jauh dapat disajikan dalam 

bentuk apa saja? 

2. Perbandingan jarak dalam sebuah peta terhadap jarak 

sebenarnya di bumi dinyatakan dalam suatu instrument 

yang disebut? 
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BAB VI 

PENYAJIAN HASIL ANALISIS 

 

A. IDENTITAS MATA KULIAH 

Fak/Jur : Pertanian / Kehutanan  

 Mata Kuliah : Penginderaan Jauh Untuk 

Kehutanan 

 Kode Mata Kuliah  : KHT 612101 

 Jumlah SKS : 3 (2-1) SKS 

 Semester / pertemuan 

ke 

: 5 / pertemuan ke 16 

Pokok Bahasan : Persiapan Citra Penginderaan 

Jauh 

 

B. CAPAIAN DAN INDIKATOR 

I. Capain Pembelajaran 

 Mahasiswa dapat menjelaskan dan melakukan rangkaian 

tindakan:  

1. Membuat layout cetak hasil analisa penginderaan jauh 

sesuai SNI. 

2. Menjelaskan penggunaan hasil analisa penginderaan 

jauh di lapangan. 
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II. Indikator Capain Pembelajaran 

 Setelah mengikuti pembelajaran maka mahasiswa 

mampu:  

1. Membuat layout cetak hasil analisa penginderaan jauh 

sesuai SNI. 

2. Menjelaskan penggunaan hasil analisa penginderaan 

jauh di lapangan. 

 

C. Penyajian Hasil Analisis  

Tahap lanjutan dari kegiatan analisis adalah penyajian dan 

penyampaian hasil dalam format, bentuk dan cara yang mudah 

dipahami oleh siapapun bahkan oleh masyarakat awam yang 

mungkin belum sekalipun mendengar penginderaan jauh. Peta 

dalam tampilan yang baik merupakan salah satu media terbaik 

untuk menyampaikan hasil analisis penginderaan jauh yang 

berisi informasi berharga sehingga diketahui oleh para 

pemangku kepentingan yang terlibat. 

Kemampuan untuk menyajikan hasil analisis penginderaan 

jauh dalam bentuk peta, baik yang masih bersifat digital atau 

bentuk cetak tentu saja sangat diperlukan. Pembuatan layout 

peta cetak juga harus mengikuti kaidah-kaidah yang berlaku 

secara global maupun nasional. Indonesia sendiri sudah 

memiliki standar baku pembuatan layout peta yang baik. 

Setidaknya terdapat dua puluh tiga (23) nomor Standar 
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Nasional indonesia (SNI) yang berhubungan dengan 

perpetaan. Oleh karena itu kemampuan membuat peta dengan 

format layout yang sesuai aturan terutama SNI menjadi 

kewajiban. 

Pada SNI 6502.2-2010 tahun 2010 diatur tentang 

spesifikasi penyajian peta rupa bumi dengan skala 1: 25.000. 

Sedangkan pada SNI 6502.3-2010 tahun 2010 diatur tentang 

spesifikasi penyajian peta rupa bumi skala 1: 50.000 dan pada 

SNI 6502.4-2010 tahun 2010 diatur tentang spesifikasi 

penyajian peta rupa bumi skala 1: 250.000 (BSN, 2010. 

 

Tautan pengunduhan data 

1. Wilayah Kota Bandar Lampung: https://goo.gl/ZFkGdR 

2. Wilayah Provinsi Lampung: https://goo.gl/y6czoW 

3. Wilayah Indonesia: https://goo.gl/RzeXZs 

 

Langkah pengerjaan: 

1. Download dan ekstrak data yang akan dijadikan sebagai 

bahan pekerjaan.  

Simpan pada folder khusus yang mudah diingat.  

Buka QGIS. Klik “File” > “Open Project” > beri nama 

project anda, misal: Latihan1. 

2. Browse ke direktori dimana anda menyimpan file bahan 

pekerjaan dibagian “Browser Panel”.  
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Klik dan geser file bahan kedalam jendela utama. 

 

 

 

 

 

 

 

 

 

 

 

3. Tiga file akan terbuka pada bagian “Layer Panel”, yaitu: 

a. BDL_KEC.shp 

b. PROV. LAMPUNG.shp 

c. WIL. IDN.shp 

Tampilan pada bagian “Layer Panel”. 
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File bahan peta ini memakai Geographic Coordinate 

System (GCS) dimana satuan unit yang dipakai adalah 

derajat.  

 

4. Kostumisasi tampilan peta dengan melakukan pembedaan 

warna tiap kecamatan dan memberikan nama kecamatan. 

Arahkan mouse pada file “BDL_KEC” pada bagian “Layer 

Panel” dan klik kanan pada mouse > pilih “Properties”. 

 

5. Pilih “Style” > pilih “Categorized” pada menu dropdown 

yang ditampilkan. Pada menu “Column”  pilih 

“Kecamatan” pada dropdown yang ditampilkan.  
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6. Memberikan warna pada layer BDL_KEC sehingga setiap 

warna akan ditampilkan dengan warna yang berbeda-beda. 

Klik pada tombol “Classify” maka akan ditampilkan 

simbol-simbol warna berbeda untuk masing-masing 

kecamatan akan ditampilkan. 

 

 

 

 

 

 

 

 

 

 

 

 

7. Klik “Apply dan “Ok” untuk mengaplikasikan konfigurasi 

pada jendela utama. 
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8. Alihkan pada jendela utama dan dapat dilihat perubahan 

tampilan pada layer BDL_KEC 

 

 

 

 

 

 

 

 

 

 

9. Menampilkan label pada masing-masing kecamatan dengan 

mengarahkan mouse pada file “BDL_KEC” pada bagian 

“Layer Panel” dan klik kanan pada mouse > pilih 

“Properties” > pilih “Labels”. 
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10. Pilih “Show label for this layer”  

 

 

 

 

11. Pada menu “Label with” pilih “Kecamatan” untuk 

memberikan label nama pada masing-masing kecamatan. 

 

 

 

 

12. Tentukan jenis dan  ukuran teks dengan klik pada menu 

“Text” kemudian lakukan tampilan pada menu pilihan. 

Pada latihan ini digunakan font: “MS Shell Dlg 2” dan 

ukuran huruf 9.00. 
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13. Menampilkan efek tulisan dengan memilih pada menu 

“Buffer”. Centang pada pilihan “Draw text buffer” 

kemudian lakukan tampilan pada menu pilihan. Pada 

latihan ini digunakan ukuran 1.00 dan warna putih. 

 

 

 

 

 

 

 

 

 

 

Hasil tampilan peta berlabel dapat dilihat pada gambar 

dibawah ini. 
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14. Menyiapkan bagian Composer sebagai tempat untuk 

membuat layout peta siap cetak. Klik “Project” > “New 

Print Composer”. 

 

 

 

 

 

 

 

 

 

15. Mucul jendela Composer title untuk pengisian judul layout 

yang akan dibuat. Biarkan kosong dan langsung klik “Ok”. 
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16. Jendela komposer otomatis muncul dengan nama 

“Composer 1”. Tampilan jendela composer dapat dilihat 

pada gambar dibawah ini. 

 

 

 

 

 

 

 

 

 

17. Munculkan tampilan file bahan dari  jendela utama ke 

jendela Composer 1 dengan mengklik pada tombol 

“Layout” > “Add Map”. 
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18. Klik dan tahan tombol kiri mouse dan gambarlah sebuah 

segiempat/kotak untuk menempatkan peta yang diinginkan 

kemudian lepaskan dan peta akan ditampilkan 

 

 

 

 

 

 

 

 

19. Anda akan melihat kotak segiempat akan dirender dengan 

peta dari jendela utama QGIS. Pengaturan posisi luas area 

peta sesuai yang diinginkan dapat dilakukan dengan 

memanfaatkan fitur yang tersedia. Klik “Layout” >  

a. “Move Item” untuk mengatur posisi kotak peta. 

b. “Move Content” untuk mengatur peta didalam kotak. 
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 atau dengan langsung klik pada shortcut yang 

tersedia pada bagian kiri jendela composer. 

 

 

 

 

20. Menyesuaikan level zoom peta dengan mengatur skala. 

Atur skala pada 125000. Skala tersebut berarti 1 cm 

pada peta mewakili 125.000 cm atau 1.250 m atau 1,25 

km jarak sebenarnya di permukaan bumi. 

 

 

 

 

 

 

 

 

 

21. Menambahkan Grid Koordinat 

a. Peta utama akan terindeks sebagai “Map 0” pada 

bagian “Items”.  

b. Pada bagian “Item properties” segmen “Main 

properties” atur skala menjadi 12500 (Skala 1: 
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125.000). Kemudian centang pada opsi “Draw map 

canvas items”. 

c. Pada segmen “Layers”, centang pada bagian “Lock 

layers” dan “Lock style for layers”.  
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22. Scroll mouse terus kebawah sampai pada segmen “Grids” 

> Klik pada tombol “+” hingga muncul tulisan “Grid 1”. 

Klik pada “Grid 1” dan lakukan pemilihan opsi berikut: 

a. Centang pada opsi “Draw “Grid 1” grid”. 

b. Grid type: “Solid” 

c. Merubah nilai “Interval x dan y” menjadi 0.05 (nilai 

koordinat yang disesuaikan dengan luasan wilayah) 
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d. Klik “change…” pada setingan “Line style”. Rubah warna 

menjadi biru atau biru muda dan “Width” menjadi 0.2.  

e. Biarkan setingan lain seperti standar. 

 

 

 

 

 

 

 

 

Perubahan tampilan pada peta utama 
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24. Menampilkan bingkai grid. Pada segmen “Grid frame”, 

pilih “Zebra”. “Frame size” 2.00 mm dan “Frame line 

thickness” 0.3 mm. Biarkan setingan lain pada keadaan 

standar.  

 

 

 

 

 

 

 

 

 

 

 

 

25. Menampilkan nilai koordinat sesuai grid  yang sudah 

dibuat sebelumnya. Terus scroll mouse kebagian bawah 

sampai terlihat segmen “Draw coordinates”, lakukan 

pengaturan seperti terlihat pada gambar. Anda dapat 

mengubah jenis huruf, ukuran huruf dan jarak tulisan dari 

frame sesuai keinginan. 
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Setingan pada segmen “Draw coordinates”. 
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Perubahan tampilan pada peta utama jendela Composer 1. 
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26. Menambahkan skala batang (Scale bar). Pilih “Add 

Scalebar” dari menu “Layout”. 

 

 

 

 

 

 

27. Lakukan pengaturan seperti pada gambar. Skala peta 

utama (Map 0) adalah 1:1,25 km sehingga pada bagian 

units perlu dilakukan perbandingan dengan bagian Fixed 

width yang merepresentasikan ukuran scalebar pada 

Composer 1. 

 a. Pada bagian “Main properties”  

 Map = Map 0 

 Style = Single Box (bias dipilih model lain)  

 b. Pada bagian “Units”  

 Scalebar units = Meters 

 Label unit multiplier = 2000.0000  

 Label for units = Km 

 c. Pada bagian “Segment”  

 Fixed width= 2500.000 units 
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Hal yang perlu diperhatikan adalah: 

Rumus = “Fixed width”: 2500 units dibagi “Label unit 

multiplier”: 2000 menghasilkan skala 1,25 Km. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Hasil Scalebar 

 

 

 

 

v 
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28. Menambahkan gambar arah mata angin. Klik Layout > 

“Add Image”. Klik-tahan mouse dan arahkan pada bagian 

peta utama. Pada segmen “Main properties” lakukan 

pengaturan “Resize mode” dengan opsi “Zoom and resize 

frame”. Cari segmen “Search directories” dan pilih gambar 

arah mata angin yang diinginkan. 

 

 

 

 

 

 

 

 

 

 

 

 

29. Menambahkan Inset peta yang menunjukkan wilayah yang 

dipetakan pada tingkatan wilayah yang lebih luas dan 

diketahui masyarakat umum. Lakukan prosedur yang sama 

seperti pada nomor 17 sampai 25. 
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30. Ubah nilai skala untuk peta inset (map 1) menjadi 3000000 

dan interval koordinat x dan y: 1.00. 

 

 

 

 

 

 

 

 

 

 

31. Tambahkan kotak segiempat dan beri warna merah untuk 

menandakan posisi wilayah yang dipetakan. Klik pada 

menu “Layout” > “Add Shape” > “Add Rectangle”. 
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32. Akan muncul tampilan Item properties secara otomatis. 

Pada segmen Shape, rubah “Style” dengan mengklik pada 

tombol “Change…” 

 

 

 

 

 

 

 

Akan mucul jendela dialog “Change”, klik pada opsi 

“Simple fill” dan sesuaikan parameter berikut: 

a. Fill = Transparent 

b. Outline = Warna merah 

c. Fill style = Solid 

d. Outline style = Solid line 

e. Join style = Milter 

f. Outline width = 0.7 

Klik “Ok”  
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Tampilan pada inset (map 1). 

 

 

 

 

 

 

 

33. Membuat kotak-kotak untuk memuat keterangan lainnya. 

Ulangi langkah 31 sampai 32 namun gunakan warna hitam 

setingan “Outline”. Sesuaikan ukuran kotak sehingga 

berbentuk seperti gambar dibawah ini. Shortcut Copy 

(Ctrl+C) dan Paste (Ctrl+v) dapat diaplikasi untuk 

mempermudah pekerjaan. Atur jumlah dan posisi kotak 

untuk peruntukan keterangan lain.  
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34. Menambahkan keterangan-keterangan lain berupa 

teks/tulisan. Akses “Layout” > “Add label”. Gambar kotak 

menggunakan mouse untuk area yang akan diberi teks.  

 

 

 

 

 

 

 

 

 

 

 

Judul peta

Skala

Legenda

Sumber

pembuat
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35. Pada segmen “Label” > “Main properties” ketik: “PETA 

WILAYAH KECAMATAN DI KOTA BANDAR 

LAMPUNG PROVINSI LAMPUNG”. 

 

 

 

 

 

 

36. Pada bagian “Appearance”, klik tombol “Font” dan 

lakukan pengaturan pada jendela “Select font” yang 

muncul. 

 

 

 

 

 

 

 

 

 

 Pilih jenis, gaya dan ukuran font atau huruf sesuai 

keinginan. Pastikan teks yang dihasilkan tidak melebihi 

ukuran kotak yang disiapkan. Kemudian klik tombol “Ok”. 
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37. Pilih setingan “Horizontal aligment” dan “Vertical 

aligment” menjadi “Center dan “Middle” untuk membuat 

teks berada ditengah-tengah kotak yang disediakan. 

 

 

 

 

 

 

 

 

 

 

 



VI-31 | P e n y a j i a n  H a s i l  A n a l i s i s  
 

 

 

 

 

 

 

 

 

 

38. Menambahkan Legenda atau keterangan peta. Pada menu 

“Layout” pilih “Add legend” dan arahkan mouse menuju 

kotak dimana legenda akan ditampilkan.  
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39. Bagian Item properties di sebelah kanan secara otomatis 

akan menampilkan segmen-segmen opsi pengaturan 

legenda. Pada segmen “Legend items”, hilangkan tanda 

centang pada opsi “Auto update”. Hal ini dilakukan agar 

pengguna dapat mengkostumisasi keterangan secara 

manual sesuai keinginan. 
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 Klik kiri mouse pada layer BDL_KEC kemudian klik 

kanan dan centang pada opsi “Hidden” agar teks 

BDL_KEC tidak dimuculkan.  
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40. Cari segmen “Main properties” pada opsi “Title” rubah 

teks Legend menjadi Keterangan (dapat juga diganti 

menjadi Legenda) atau teks lain sesuai keinginan 

pengguna. 

 

 

 

 

 

 

 

41. Lakukan pengaturan untuk menyesuaikan jenis, gaya dan 

ukuran huruf sesuai kebutuhan pengguna seperti pada 

nomor 36. Untuk memisah kolom teks, lakukan perubahan 

pada segmen “Columns” seperti pada gambar. 
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42. Lakukan kombinasi dari petunjuk-petunjuk dan pengaturan posisi sehingga dihasilkan layout peta 

seperti pada gambar dibawah ini. 
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43. Simpan pekerjaan Composer 1  

a. Menyimpan file pekerjaan Composer 1 agar dapat 

dibuka kembali maka klik pada menu “Composer” > 

“Save Project”. 

b. Untuk menyimpan pekerjaan pada Composer 1 sebagai 

template yang dapat digunakan sebagai template peta 

untuk pekerjaan lainnya, pilih menu “Save as 

Template…”.  

c. Untuk menyimpan pekerjaan pada Composer 1 dalam 

format gambar, pdf atau svg sehingga dapat dibuka 

pada aplikasi perangkat lunak umum lainnya maka  

pilih menu “Save as Image…” atau “Save as PDF…” 

atau “Save as SVG…”. Pada pilihan resolusi ekspor 

gambar, pastikan nilai “Export resolution” minimal 300 

DPI atau lebih sehingga hasil output gambar peta tetap 

berkualitas baik. 
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D.  Rangkuman 

1. Kemampuan menyajikan data hasil analisis penginderaan 

jauh sangat diperlukan. 

2. Pembuatan layout peta cetak juga harus mengikuti kaidah-

kaidah yang berlaku secara global maupun nasional.  

2. Terdapat dua puluh tiga (23) nomor Standar Nasional 

indonesia (SNI) yang berhubungan dengan perpetaan.  

3. Pada SNI 6502.2-2010 tahun 2010 diatur tentang 

spesifikasi penyajian peta rupa bumi dengan skala 1: 

25.000. Sedangkan pada SNI 6502.3-2010 tahun 2010 

diatur tentang spesifikasi penyajian peta rupa bumi skala 1: 

50.000 dan pada SNI 6502.4-2010 tahun 2010 diatur 
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tentang spesifikasi penyajian peta rupa bumi skala 1: 

250.000. 

4. Komponen yang harus ada dalam sebuah peta adalah peta 

utama, inset, judul peta, skala, system proyeksi, datum, 

legenda atau ketarangan, sumber peta, arah mata angin dan 

pihak pembuat peta. 

 

E.  Pertanyaan Dan Evaluasi  

1. Jelaskan urgensi sebuah peta! 

2. Apa yang dimaksud dengan skala? 

3. Apakah fungsi bagian legenda dalam sebuah peta? 

4. Apakah fungsi inset pada sebuah peta? 

5. Jelaskan arti dari sebuah peta dengan skala 1: 250.000! 

 

F. Daftar Pustaka 

BSN. 2010. Standar Nasional Indonesia (SNI) 6502.2-2010: 

Spesifikasi Penyajian Peta Rupa Bumi - Bagian 2: Skala 

1:25.000 . Badan Standarisasi Nasional. Jakarta. 

BSN. 2010. Standar Nasional Indonesia (SNI) 6502.3-2010: 

Spesifikasi Penyajian Peta Rupa Bumi - Bagian 3: Skala 

1:50.000 . Badan Standarisasi Nasional. Jakarta. 

BSN. 2010. Standar Nasional Indonesia (SNI) 6502.4-2010: 

Spesifikasi Penyajian Peta Rupa Bumi - Bagian 3: Skala 

1:250.000 . Badan Standarisasi Nasional. Jakarta. 
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GLOSSARY 

 

Penginderaan jauh adalah ilmu untuk mendapatkan informasi 
tentang permukaan bumi seperti lahan dan air dari citra yang 
diperoleh dari jarak jauh. 
 
Penginderan Jauh atau “Remote Sensing” digunakan untuk 
menyebut suatu kegiatan pendugaan keterangan suatu objek 

dari jarak jauh tanpa perlu menyentuh atau mendatanginya. 

Resolusi spasial adalah ukuran terkecil obyek yang dapat 
direkam oleh suatu sistem sensor sehingga menunjukkan 
kerincian informasi yang dapat disajikan oleh suatu sistem 

sensor. 

Resolusi Citra (citra resolution) adalah kualitas lensa yang 
dinyatakan dengan jumlah maksimum garis pada tiap 

milimeter yang masih dapat dipisahkan pada citra 

Resolusi spektral menunjukkan kerincian panjang gelombang 
elektromagnetik yang digunakan dalam perekaman obyek 

pada sensor. 

Resolusi temporal adalah intensitas perekaman suatu wahana 

pada tempat/posisi yang sama. 

Resolusi radiometrik adalah tingkat kepekaan sensor terhadap 
perbedaan terkecil kekuatan sinyal yang dihasilkan dari objek 
perekam sehingga dibedakan dari segi warna dan intensitas 

cahaya. 

Data Vektor adalah data yang menampilkan pola keruangan 

dalam bentuk titik, garis, kurva atau poligon 
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Data Raster, struktur data dot matrix, yang mewakili kotak 
grid pixel pada umumnya, atau warna poin, yang dapat di lihat 

via monitor, kertas, atau media lainnya. 

Path adalah urutan kotak berdasarkan baris dari sebelah timur 

ke barat.  

Row adalah urutan baris dari arah utara ke selatan. 

Koreksi radiometrik merupakan tindakan yang dilakukan 

untuk mengkoreksi nilai piksel pada citra. 

Pan sharpening atau penajaman citra adalah tindakan yang 
dilakukan untuk memperbaiki resolusi spasial citra yang akan 

dijadikan sebagai bahan analisis. 

Mosaic scene adalah penggabungan beberapa scene untuk 

menyesuaikan kebutuhan lokasi analisis. 

Clipping adalah kegiatan analisis spasial berupa pemotongan 
scene sehingga citra hanya menunjukkan area sesuai dengan 

kebutuhan wiayah penelitian saja. 

NDVI adalah indeks yang menggambarkan tingkat kehijauan 

suatu tanaman. 
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